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Chapter One:  Getting Started 

Overview 
The FAXCOM Client is a standalone application for sending and receiving faxes.  It 
is organized similarly to an email Inbox, with folders and subfolders in which to 
store your sent and received items. 

You may also be given Share Rights to other fax user accounts, with the specific fax 
functions you can perform determined by the specific permissions you have been 
given to the user account.  Refer to Chapter Four for information on performing fax 
functions as a user with Share Rights to another user account. 

The FAXCOM Client now includes a Viewing Pane for viewing the contents of a 
received fax without having to open it.  You simply click the received fax item to 
view its contents in the Viewing Pane, which you can position either on the Bottom 
or on the Right.  You can also preview an outgoing fax in the Viewing pane (or in 
the configured fax viewer) before it is actually transmitted by selecting the Preview 
checkbox on the Send Fax dialog when you create the outgoing fax.   

You can launch the FAXCOM Client in two ways: 

• By selecting Start…Programs…FAXCOM…FAXCOM Client. 

• By working within a Windows application such as MS Word, and selecting 
File…Print…Biscom Fax Printer in order to fax the application output.  You are 
then automatically transferred to the FAXCOM Client Send Fax dialog in order to 
address and send the fax. 

  You can do all of the following with the FAXCOM Client: 

• Specify your options for using the FAXCOM Client (Chapter One). 

• Organize faxes within folders and subfolders (Chapter One). 

• Send faxes, which includes previewing the fax before it is actually transmitted 
(Chapter Two). 

• Resend a failed/saved fax from a Sent fax folder (Chapter Two). 
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• Receive faxes, which includes viewing the fax, forwarding the fax, sending the 
fax to a fax recipient, sending the fax to a mail recipient, adding a note to the 
fax entry, and getting the next unread fax (Chapter Three). 

• Perform fax functions within a user account to which you have been given Share 
Rights (Chapter Four). 

• View and manipulate the received fax within Biscom’s fax viewer, the FAXCOM 
Viewer (Chapter Five). 

• Manage your outgoing faxes in the Pending Queue and view the Activity Log 
(Chapter Six). 

• Create a phonebook of fax recipients (Chapter Seven). 

• Use the Archive function, whereby you can send folders of faxes either to a 
network location or a CD, and then later restore (i.e., access) the archived faxes 
(Chapter Eight). 

• If so configured, use additional FAXCOM Client tools:  the Advanced Fax Routing 
utility, for creating rules that automatically route incoming faxes; and the Mail 
Merge utility, which enables you to merge and fax customized documents 
prepared from a main document and a data source.  You can also set an Out-
of-Office flag for rerouting received faxes – in the event an Advanced Fax 
Routing rule exists to execute that action. (Chapter Nine). 

Logging in to FAXCOM Client 
Note:  Logging in to FAXCOM Client – with or without a password – applies to 
FAXCOM Suite for Windows users only.  It does NOT apply to FAXCOM for NDS 
FAXCOM Client users. 

When you log in to FAXCOM Client, you specify the location on the network where 
your administrator has installed the fax service software, and the name established 
for you to use the service.  Your site may also require you to enter a password to 
access the fax service.  (If appropriate, you can change your password within 
FAXCOM Client.) 

Do the following to log in to FAXCOM Client: 
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Select Start…Programs…FAXCOM…FAXCOM Client to display the main window 
(Figure 1-1). 

 

Figure 1-1.  FAXCOM Client Main Window 

Select File…Login to display the Login dialog. 

 

Figure 1-2.  Login Dialog 

As advised by your fax service administrator, select the appropriate Login with 
option, either: 

Active Directory Account – uses the information specified for you in the Active 
Directory directory service so that no login to the fax service is required. 
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NT Domain Account – uses the same User Name and Password combination with 
which you identify yourself when logging into Windows 

FAXCOM Account – uses the name specified for you when the fax service 
administrator added you to the fax service User List 

Review the information in the Service Path and User Name fields.  If the fields are 
blank, consult with your fax service administrator. 

To change the information in either, type over the existing information; to search 
for the correct Service Path, click the Browse button.  Click OK to save the changes. 

Changing your Password 
Your site may require you to specify a password in order to log in to the fax service.  
Do the following if it is necessary to change your password: 

1. Select Tools…Change Password…. 

2. In the Old Password box, enter your current password; In the New Password 
field, enter the new password; in the Retype Password box, enter your new 
password again; click OK to save your changes. 

Specifying your FAXCOM Options 
FAXCOM options establish your defaults for using the fax service – which you can 
override for a specific fax from the Send Fax dialog. 

You configure fax service options in the following categories: 

• Personal Info 

• Transmit 

• Monitor 

• Phonebook 

• Viewer/Log Options 
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You configure your FAXCOM options either by selecting Tools…Options or clicking 

the Options toolbar button  and configuring each tab.  Once you configure the 
tab, click OK to exit the Options tabs or click Apply to select another Options tab.) 

 

Figure 1-3.  Personal Info Tab 

Specifying your Personal Information 
Personal Info (as shown on Figure 1-3), specifies the default sender information 
that will be printed on the cover page of an outgoing fax (and which you can 
override for a specific fax from the Send Fax dialog). 

Specifying your Transmit Defaults 
Transmit defaults specify the default settings to use when you send a fax. 
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Figure 1-4.  Transmit Tab 

You specify default settings for the following options: 

Resolution – dots per inch (dpi); either Standard (200 X 100 dpi) or Detail (200 X 
200 dpi) 

Note:  be aware that the Detail image produces a better quality image but takes 
about twice as long to send.  

Return Status – whether you are notified of the status of all outgoing faxes or 
the failed only 

Cover Page File – displays the cover page files your fax service administrator has 
made available to you; these include the system-wide default cover page 
(Default), as well as any specifically-named cover pages and the NO Coverpage 
selection (if the default is not to include a cover page); if no file is specified, the 
system-wide default is used. 
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Send and Save to – displays the top level of your folder listing so that you can 

highlight a Sent Fax folder  to be the default folder into which you save fax 
transmissions on the Send Fax dialog 

Note:  Be aware that you can always select another folder on the Send Fax dialog for 
a specific outgoing fax (and create a new one on-the-fly). 

Default to Send and Save – check to specify that your default preference when 
sending a fax is to both send the fax and save it in a Folder.  If you clear this 
box, the default is to send the fax only – and you must explicitly check the Save 
box on the Send Fax dialog if you want to save it. 

Specifying Monitor Notifications 
You specify the fax events for which you receive a notification status (which consists 
of a workstation beep and a displayed message box) on the Monitor tab: 

 

Figure 1-5.  Monitor Tab 
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1. Either click the Options toolbar button and select Monitor or select 
Tools…Options…Monitor. 

2. Check the Enable Inbox Notifications checkbox to be notified of the status of a 
fax you have received.  The Details box is enabled.  Check the Details checkbox 
to specify that the Receive Status message not only notifies you that a fax was 
received, but also includes such detailed status information as whether the fax 
was successfully received, the date/time of receipt, the number of pages, the 
Sender ID, etc. 

3. Check the Enable Shared Account Notifications checkbox to be notified of the 
status of a fax that has been received in the LAST OPENED shared fax user 
account to which you have access. (Note that detailed status information is not 
available for faxes received into a user account to which you have Share Rights.) 

4. Check the Enable Transmit Notification checkbox to be notified of the status of 
a fax you have sent.  The Details checkbox is enabled.  Check the Details 
checkbox to specify that the Transmit Status message not only notifies you that 
your fax was sent, but also includes such detailed status information as the fax 
recipient, pages sent, connect time, retry count, any error code if unsuccessful, 
etc. 

5. In the Close Message Box After checkbox, specify the time (in seconds) that the 
notification message box is displayed.  As explained on the dialog, if you 
specify a time greater than 300 seconds (five minutes), the message box is 
closed only when you explicitly close it.   

6. Check the Show new fax icon in the notification area checkbox to specify that an 
icon indicating receipt of an incoming fax be displayed in the right-hand side of 
the status bar 

7. Specify a time (in seconds) for the Refresh Interval, which is the time the 
FAXCOM Client program will use to update the screen (such as the Received Fax 
folder that you are viewing).  As explained on the dialog, if you specify a time 
greater than 60 seconds (one minute), the display will refresh only when an 
event occurs. 

Click OK or Apply to save the information.  (Clicking OK exits the Options property 
pages while clicking Apply enables you to select another Options property page.) 
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Note:  in order to take advantage of the Faxcom Monitor feature, you must leave the 
FAXCOM Client program running in the background.   

Specifying your Phonebook Type 
You can specify that a phonebook be shared with other individuals.  Whether you 
access a Shared phonebook from the Send Fax dialog, or directly from the FAXCOM 
Client menu bar, the default mode of access is Read-only.  If you are to be given 
Read-Write access to a Shared phonebook, your fax service administrator must 
configure that access for you. 

 

Figure 1-6.  Phonebook Tab 

• To use a Shared phonebook, either click the Options toolbar button and select 
Phonebook or select Tools…Options…Phonebook.  Check the Shared radio 
button, and in the Shared Phonebook Path field, either enter the path to the 
phonebook as communicated to you by your fax service administrator or select 
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the path from your file listing.  Click OK or Apply to save the information.  
(Clicking OK exits the Options property pages while clicking Apply enables you 
to select another Options property page.) 

Once you have selected Shared on the Phonebook options tab, it is the Shared 
phonebook that will be displayed when you click the Private PB… button on the 
Send Fax dialog.  To cause your personal Private phonebook to be displayed 
when you click the Send Fax dialog Private PB… button, you would have to 
access the Options…Phonebook tab and select the Private radio button.   

Specifying your Default Fax Viewer and Log Display Options 
You can specify the default fax viewer to be invoked for viewing received faxes, as 
well as whether or not to display the Activity Log and Pending Queue. 

 

Figure 1-7.  Viewer/Log Options Tab 
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1. In the Fax Viewer Application Path field, leave the field blank to use Biscom’s 
FAXCOM Viewer.  You can also specify any Tiff viewer of your choice, either by 
entering its full path (or by clicking the Browse button and selecting the 
appropriate file). 

2. In the Display Options area, check the Activity Log and/or Pending Queue check 
boxes to specify that these logs be displayed for your view.  (Clear a box if you 
do not want to display the corresponding log.) 

The Activity Log lists all attempted fax transmissions, both successful and 
unsuccessful, and any received faxes for the entire fax service. 

The Pending Queue lists all faxes queued for transmission and enables you to 
see what place your jobs occupy in the queue.  You can select your own jobs 
and make last-minute changes to their transmission status and destination fax 
number.    

3. In the Confirm Delete area, if appropriate, uncheck the Confirm Delete Received 
Faxes and/or Confirm Delete Sent Faxes checkboxes if you do NOT want to 
receive a message prompting you to confirm your deletions of selected faxes.  

Organizing Faxes into Folders and Subfolders 
Within FAXCOM Client you can create folders and subfolders in which to store faxes.  
By default, two folders are already created for you, the Inbox folder to hold received 
faxes, and the Sent folder to hold return status messages for transmitted faxes, as 
shown in Figure 1-8. 

 

Figure 1-8.  Default Folders 
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When you attempt to create a new folder at the topmost Mailbox level, for example, 

, you are prompted whether the folder to be created 
is for Received faxes or Sent faxes.  Otherwise, you can add only a Received fax 
subfolder under a Received fax folder, and only a Sent fax subfolder under a Sent 

fax folder.  A Received fax folder is identified with the following icon .  A Sent 

fax folder is identified with the following icon .  A Received fax folder to which 

you have been given Share Rights is identified with the following icon .  A Sent 
fax subfolder to which you have been given Share Rights is identified with the 

following icon .   

To move faxes from one folder to another, select the faxes as follows, then drag 
and drop them into the appropriate folder: 

To select consecutive faxes, click the first item, press and hold down SHIFT, and 
then click the last fax. 

To select faxes that are not consecutive, press and hold down CTRL, and then 
click each fax. 

To select all faxes, press Ctrl-A. 

In addition to dragging and dropping faxes between folders, you can also press the 
following key combinations to move selected faxes between folders: 

Ctrl-C to copy 

Ctrl-V to paste 

Ctrl-X to cut (in order to paste into another folder) 
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Chapter Two:  Sending a Fax and Using a Sent Fax Folder 

Overview 
This chapter explains the various ways you can send a fax, including resending 
failed/saved faxes from a personal (not shared) Sent fax folder.  Sending faxes from 
a shared user account varies according to your specific Share Rights permissions, as 
described in Chapter Four. 

Sending a Fax Overview 
You have the following send capabilities: 

• Send a brief fax memo 

• Send a fax from any Windows application by "printing" the application output to 
the Biscom Fax Printer 

• Send a fax that includes up to 100 attachments, from the following sources: 

− Files selected from Windows Explorer 

− Files opened in any Windows application and “printed” to the Biscom Fax 
Printer 

− Previously-received faxes stored within FAXCOM Client Received fax folders 

• Save an outgoing fax in a Sent fax folder  

• Resend a failed/saved fax from a Sent fax folder  

Accessing the Send Fax Dialog 
You can access the Send Fax dialog in four ways: 

• From the FAXCOM Client toolbar, either by selecting Send Fax… from the File 

pull-down menu, or by clicking the Send Fax  toolbar button. 

• From a Windows application when you "print" to the Biscom Fax Printer. 
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• From a FAXCOM Client phonebook (either Public or Private) when you select fax 
recipient users/groups, right-click and select Send Fax. 

• From a Received fax folder, when you select a previously-received fax, right-
click and select Send to Fax Recipient. 

Filling out the Send Fax Dialog 

 

Figure 2-1.  Send Fax Dialog 

To send a fax, the only information required on the Send Fax dialog is the 
destination fax number in the Fax Number box (in addition to the fax contents, 
which consists either of a cover page memo or a file attachment). 

In addition, when you configured your options for using the fax service, you 
established certain default settings for sending a fax that are pre-filled for you on 
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the Send Fax dialog, and you can change any of these default settings for an 
individual fax on the Send Fax dialog. 

1. After accessing the Send Fax dialog and addressing the fax, fill out the Send Fax 
dialog as follows: 

If appropriate, click the  button (to the right of the Sent From Fax Number 
field) to change the pre-filled information in the Sent From area (where pieces 
of information such as Company Name and Voice Number are displayed only if 
there is a corresponding heading on the cover page). 

In the Cover Page area, enter a subject to be printed on the cover page. 

If appropriate, select a different cover page from the Cover Page File Name 
drop-down list box. 

Either selecting Default or having no entry in this box causes the system-wide 
default cover page to be used. 

Checking the NO Cover Page box causes no cover page to be sent. 

In the Schedule area, if appropriate, change the transmission time from the 
default of ASAP to either Offpeak or Delay Until. 

If you selected Delay Until, in the Date and Time boxes, enter the date and time 
to send the fax. 

If you selected Offpeak, the fax is sent at whatever offpeak time has been set by 
the fax service administrator (typically a time such as 1:00 AM, when phone 
rates are less expensive). 

In the Priority box, select a delivery priority from the options available to you – 
being aware that when your fax service administrator configured you as a fax 
service user, he/she established the maximum priority available to you.  (In 
other words, the Urgent priority may be configured as the top priority available 
for an employee who is head of the department, while High may be configured 
as the top priority available to individual members of the department.)     

2. As appropriate, check the Send check box only, or both the Send and Save check 
boxes, or the Save check box only (depending on whether you want to transmit 
the fax only, transmit and save the fax, or save it only) to save the outgoing fax 
in a Folder.  The Folder name and Note fields are enabled. 
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3. From the Folder name list, select the Transmit (i.e., Sent Fax) folder in which to 

store the fax.  A Transmit folder is identified as .  To create a new 
Transmit folder on-the-fly, specify the name of the new folder in the Folder 
name list.  Once you click the Send button, you will be prompted that the 
specified folder does not exist and asking if you want to create it.  Click Yes to 
create the new Transmit folder. 

In the Note field, specify a REQUIRED note (up to a maximum of 40 characters) 
to identify the fax in your Folder. 

Note:  When you establish your Transmit options for using the fax service, you can 
specify that the default setting be Send and Save, so that the Save check box is 
always selected for you. 

4. If you want to be able to preview the fax in the Pending Queue before actually 
sending it, check the Preview check box.  Note that when you check Preview, the 
Send check box is automatically deselected.   You then release the fax for actual 
transmission from the Pending Queue. 

5. Click the Send button.  (Depending on your choice, the fax is sent only, sent and 
saved, or saved only.) 

Addressing a Fax 
However you access the Send Fax dialog, you use either of these methods to 
address the fax: 

• Automatically transfer names and fax numbers from phonebooks  

• Enter the names and fax numbers manually 

Automatically Transferring Names and Fax Numbers from 
Phonebooks 
Do the following to access Private/Public phonebooks and groups from the Send 
Fax dialog and automatically transfer fax recipient names and numbers: 

1. On the Send Fax dialog, click either the Private PB… or Public PB… button to 
display the specified phonebook. 
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2. To select an entry, either highlight the entry and click the Add button or 
double-click the entry to move it to the Recipients box. 

3. To remove a selected entry, highlight the entry and click the Remove button; to 
remove all selected entries, click the Remove All button (noting that it is not 
necessary to highlight the entries first). 

4. Continue to select entries as needed.  Click OK to be returned to the Send Fax 
dialog. 

Entering Names and Fax Numbers Manually 
Do the following to enter the names and fax numbers of fax recipients manually in 
the Send To area of the Send Fax dialog – noting that the only information required 
to send a fax is the fax number in the Fax Number field (in addition to the fax 
contents, which consists either of a cover page memo or a file attachment): 

1. In the Name box, enter the name of the fax recipient.  Note that if you enter 
part of the name of an individual/group who has already been added to either 
the Public or Private phonebook, when you tab to another field from the Name 
box, the auto-complete function completes the full name for you and adds the 
previously-specified information in the appropriate Send To boxes.  

2. If you wish, tab to the Company box and enter the company of the fax recipient. 

3. Tab to the Fax Number box and enter the destination fax number (the only 
information required to send a fax). 

4. If you wish, tab to the Voice Number box and enter the voice number of the 
recipient. 

5. If using the Accounting Function (whereby you can charge back fax-related 
costs according to recipient), tab to the Account Number field and enter a valid 
account number. 

6. To automatically add the recipient to your Private phonebook, click the Add to 
PB… button to display the Phonebook Record - Modify dialog.  Click OK to 
accept the recipient information and be returned to the Send Fax dialog. 
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7. To add additional recipients, click the New button in the Send To area and 
repeat steps 1 through 6.  Move through your list of fax recipients by clicking 
the appropriate button: 

  displays information for the first fax recipient added to the list 

  displays information for the previous fax recipient added to the list 

  displays information for the next fax recipient added to the list 

  displays information for the last fax recipient added to the list 

  clears the Send To fields in order to add a new fax recipient to the list 

To delete an entry, click the Remove button when the entry is displayed. 

To change an entry, click the appropriate button to display the recipient and 
change the information. 

Continue filling out the Send Fax dialog, clicking the Send button to send the fax. 

Creating a Brief Cover Page Fax Memo 
You can create a fax message that will be printed on the cover page.  In the 
message, you can also include commands that invoke a scanned image of your 
signature and/or invoke pre-printed images.  When you access FAXCOM Client to 
send a fax by "printing" your Windows application to the Biscom Fax Printer, no 
memo is required to comprise your fax.  When you access FAXCOM Client directly or 
from a FAXCOM Client phonebook, however, a cover page memo is required unless 
you attach an additional file. 

Sending a Fax from any Windows Application 
You can access the Send Fax dialog from any Windows application by "printing" the 
application output to the Biscom Fax Printer, as follows:. 

1. Within a Windows application, “print” the application output to the Biscom Fax 
Printer and be transferred to the Send Fax dialog, with the name of the 
temporary print file created in the Attachments list box. 
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2. Fill out the Send Fax dialog as described in the preceding sections, being aware 
that no cover page memo is required when sending a fax that includes at least 
one attachment. 

Sending a Fax that Includes up to 100 Attachments 
DEPENDING ON HOW YOUR FAX SERVICE IS CONFIGURED, you can include up to 100 
attachments to your fax in addition to your cover page fax memo.  The sources for 
the attachments can be any or all of the following: 

• Files you select in Windows Explorer 

• Received faxes in any FAXCOM Client Received fax folder 

• Any open Windows application file that you “print” to the Biscom Fax Printer  

Note:  Verify with your fax service administrator the exact number of attachments 
you are able to attach to an outgoing fax. 

If your site has the Translation Server option, you can add more attachment types 
than are supported with the basic FAXCOM server program (and you are advised to 
consult with your fax service administrator to determine what file types you can 
attach when invoking FAXCOM Client to send a fax). 

Do the following to attach files: 

1. Either click the Send Fax toolbar button  or select File…Send Fax…. 

2. On the Send Fax dialog, in the Attachments Name field, enter the full path name 
of the attachment and click the Add File button to add it to the list – up to the 
maximum number you have been told by your fax service administrator.  (To 
remove a file you have added to the list, highlight the file and click the Remove 
File button.) 

3. To search for files, click the Browse… button to display the Find Files dialog and 
locate the files in your file listing.  Click OK to be returned to the Send Fax 
dialog. 

4. To use the Add to List function, whereby you “print” Windows application output 
as fax attachments, click the Add to List: button.  Once you click the Add to List: 
button, the FAXCOM Client begins keeping a running list of the files you attach, 
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enabling you to close the Send Fax dialog and select additional attachments to 
add to the list of attachments.  Launch the Windows application and open the file 
to be attached to the fax.  Select File..Print…Biscom Fax Printer.  You are 
returned to the Send Fax dialog with the Windows application file added in the 
Attachments list.  

5. To add one or more received faxes, click the Add to List: button; click the 

FAXCOM Client icon  in the taskbar to return to the FAXCOM Client main 
window; open a Received fax folder; select one or more received faxes, right-
click and select Send to Fax Recipient to be returned to the Send Fax dialog with 
the selected fax(es) added to the Attachments list.  

6. As appropriate, continue the process of specifying file names, clicking the 
Browse... button to select files, and clicking the Add to List: button to open and 
“print” Windows application files and select Received faxes.  

7. When you have finished adding all the files you want to the fax, fill out the Send 
Fax dialog, address the fax, and create a brief cover page fax memo.  Click Send 
to send the fax. 

Sending a Fax from a FAXCOM Client Phonebook 
From either the Private phonebook or the Public phonebook, do the following to 
send a fax to selected individual(s)/group(s) in the phonebook: 

1. Within the phonebook, highlight the user(s)/group(s) and right-click to display 
the shortcut menu; select Send Fax… to be automatically transferred to the Send 
Fax dialog. 

2. Fill out the Send Fax dialog, address the fax, and, if appropriate, create a brief 
cover page memo.  Click the Send button to send the fax. 

Customizing your Fax 
You can merge your outgoing fax with pre-printed images that your fax service 
administrator has installed on the server.  These images are of two types: 

• A scanned image of your personal handwritten signature 
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• A form such as 

- a map with directions to your place of business 

- a customer survey 

- an order form 

You issue simple commands in your outgoing fax cover page memo to invoke a 
scanned copy of your signature and/or invoke pre-printed images. 

Invoke a Scanned Image of your Signature 
If a scanned copy of your handwritten signature is stored on the fax server, do the 
following to cause an image of your handwritten signature to be inserted in your 
cover page fax memo: 

1. From the Send Fax dialog, click the Memo… button to create your cover page 
memo. 

2. Enter an UPPERCASE command IN THE EXACT LOCATION on the Create Memo 
screen where you want your signature to appear.  The signature command has 
the following format: 

 $SIG XXXX$ 

where XXXX is the 4-character (maximum) filename of the signature, for example 
$SIG BILL$, $SIG FRED$, $SIG MARY$ 

If necessary, consult with your fax service administrator to learn the name of the 
file that calls your signature. 

Invoke Pre-printed Images 
Do the following to merge an outgoing fax with a pre-printed form that your fax 
service administrator has installed on the server: 

1. From the Send Fax dialog, click the Memo… button to create your cover page 
memo. 

2. Enter an UPPERCASE command ANYWHERE ON THE PAGE that you want overlaid 
with the form.  The command has the following format: 

 $FORM XXXX$ 
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where XXXX is the 4-character (maximum) filename of the form, for example,  

$FORM MAP$, $FORM SAVE$, $FORM SMPL$ 

3. To force a form to begin on a new page, enter the following command in 
UPPERCASE BEFORE the $FORM$ command: 

 $NEWPAGE$ 

4. To merge multiple forms into one fax, enter the $NEWPAGE$ command between 
each $FORM$ command, as follows: 

 $NEWPAGE$ 
 $FORM MAP$ 
 $NEWPAGE$ 

 $FORM SAVE$ 
 $NEWPAGE$ 
 $FORM SMPL$ 

Saving an Outgoing Fax in a Folder 
Do the following to save the fax you have just prepared for transmission in a folder 
or subfolder: 

1. On the Send Fax dialog, either check both the Send and Save check boxes or 
check only the Save check box (depending on whether you want to transmit the 
saved fax or just save it).  The Folder name and Note fields are enabled. 

2. From the Folder name list, select the Sent fax folder (identified as ) in 
which to store the fax.  To create a new Sent fax folder on-the-fly, specify the 
name of the new folder in the Folder name list.  Once you click the Send button, 
you will be prompted that the specified Sent fax folder does not exist and 
asking if you want to create it.  Click Yes to create the new Sent fax folder. 

3. In the Note field, specify a REQUIRED note to identify the fax in your folder.  

4. Click the Send button.  (Depending on your choice, the fax is sent and saved or 
saved only.) 

Note:  when you establish your Transmit options for using the fax service, you can 
specify that the default setting be Send and Save. 
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Once the fax has been saved into a Sent fax folder, you can select the fax, right-
click and select Review/Submit… to be automatically transferred to the Send Fax 
dialog in order to have the opportunity to modify the previously-specified 
transmission information before resending. 

Previewing an Outgoing Fax 
Before actually transmitting a fax, you can preview its contents by doing the 
following: 

1. When addressing and creating the fax on the Send Fax dialog (Figure 2-1), 
check the Preview check box.  Notice that the Send check box is automatically 
deselected. 

2. Click the Send button to send the fax to the fax server. 

3. Select the Pending Queue (Figure 2-2), either by selecting Logs…Pending Queue 

or clicking the Pending Queue item  in the Folder list. 
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Figure 2-2.  Pending Queue 

4. Locate the appropriate outgoing fax and note its Status.  Depending on the 
complexity of the fax contents, the number of jobs queued, the performance of 
the fax gateway, etc., you may or may not see all three of the following 
successive conditions:  Submitting PREVIEW, Preparing PREVIEW, Ready for 
PREVIEW. 

5. When the Status is Ready for PREVIEW, do either of the following: 

• Click the fax entry to display it in the Viewing pane.  Use the Viewing pane 
toolbar buttons for full viewing capabilities, where 

 – rotates the image 

  – goes to the previous page 
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  – goes to the next page 

 – zooms in 

 – zooms out 

 – fits to window 

 – fits horizontally 

 – fits vertically 

• Select the fax entry, right-click and select Preview from the shortcut menu.  
The fax is opened either in the FAXCOM Viewer or in the fax viewer whose 
application path you specified on the Viewer/Log Options tab. 

6. If you have opened the outgoing fax in the Viewing Pane, with the fax entry 
selected, right-click and select Release from the shortcut menu. 

If you have opened the outgoing fax in FAXCOM Viewer, select File…Release Fax 
within the FAXCOM Viewer to actually send the fax – or you can exit back to the 
Pending Queue, select the fax entry, right-click and select Release from the 
shortcut menu. 

If you have opened the outgoing fax in another fax viewer, exit the viewer and 
return to the Pending Queue.  With the fax entry selected, right-click and select 
Release from the shortcut menu. 

Using Sent Fax Folders 
Within FAXCOM Client you can create folders and subfolders in which to store faxes.  
By default, two folders are already created for you, the Inbox folder to hold received 
faxes, and the Sent folder to hold Return Status messages for transmitted faxes, as 
shown below. 
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When you attempt to create a new folder at the topmost Mailbox level, for example, 

, you are prompted whether the folder is for Received 
faxes or Sent faxes.  Otherwise, you can add only a Received fax subfolder under a 
Received fax folder, and only a Sent fax subfolder under a Sent fax folder.  A 
Received fax folder is identified with the following icon .  A Sent fax folder is 
identified with the following icon . 

In addition to the automatically-created Sent folder to which Return Status 
messages are delivered for outgoing faxes, you can create as many Sent fax folders 
as you wish in order to save outgoing faxes. 

From the automatically-created Sent folder, you can resend any faxes that failed to 
be transmitted, which is indicated by the fact that the Status field does not specify 
‟ok”.  You can also send any outgoing faxes you saved into a Sent fax folder, or 
resend any faxes you previously both sent and saved into a Sent fax folder.  In 
addition, you can print a list of the contents of a Sent fax folder and the Sent Fax 
entry details. 

You can select all faxes in a Sent Fax folder by pressing Ctrl-A.  

Do the following to use a Sent Fax folder (Figure 2-3): 
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Figure 2-3.  Sent Fax Folder 

1. Open the appropriate folder. 

2. View the following information: 

State – displays an icon for the fax, according to whether it was saved , 

failed to be transmitted , or sent successfully .  

Job ID – unique identifying number assigned by the fax service to track the fax; 
a transmitted fax retains the same job ID, regardless of how many attempts at 
transmission.  When the Job ID reaches 9999, numbering restarts at 0001.  (A 
saved fax always has a Job ID of 0000. 

Attachment Count – the number of files attached to the outgoing fax 

Date/Time – of final transmission attempt 

Name – of fax recipient 

Number – of fax recipient 

Attempts – number of retries to transmit the fax 

Status Code – a four-digit code that indicates the outcome of the fax; other than 
0000 for ok, the status codes are error codes for why the fax was not 
successfully transmitted. 
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Status – abbreviated explanation of whether the transmission was successful.  
Successful transmissions are indicated by “ok.”  Unsuccessful transmissions are 
indicated by such terms as “voic,” “noan,” “busy,” “nois,” etc. 

Status Description – a fuller description of the outcome of the fax 

Transfer Rate – baud rate of the exchange, either 14400, 12000, 9600, 7200, 
4800 or 2400 

Pages Sent – number of fax pages that were transmitted 

Connect Time – amount of time in seconds on the phone to transmit the fax 

Subject – information entered in the Subject field on the Send Fax dialog box 

Fax Port – FAXCOM Server port on which the fax was transmitted 

Note(s) – any descriptive notes added to the entry in the Sent fax folder  

Note:  By default, two additional column headings are not displayed but are 
available to be displayed:   ID Tag, which is reserved for third-party applications, 
and UniqueJobID, which is used by the FAXCOM Job Tracking application. 

3. If appropriate, click the column headings to toggle between an 
ascending/descending sort. 

4. To add/remove columns, right-click anywhere in the Sent fax folder and select 
Add/Remove Columns from the shortcut menu.  In the Select Columns dialog 
that is displayed, select entries in the Available Columns list and move them 
into the Displayed Columns list, either by double-clicking the entries or by 
using the Add/Add All buttons.  Remove entries from the Displayed Columns 
list, either by double-clicking the entry or using the Remove/Remove All 
buttons.  Click the Move Up/Move Down buttons as appropriate to cause the 
entry to move to the left-hand/right-hand side of the Sent fax folder.  Click OK 
to be returned to the Sent fax folder with your selections enabled. 

5. To display the information for a sent fax in its own window, select the fax entry 
and right-click; select Details.  Note that you can execute the Delete, Move to…, 
and Review/Submit… functions (described below) from within the Details 
window. 

6. To add one or more notes to one or more entries, select the entries, right-click 
and select Add Note(s) from the shortcut menu.  If your fax service 
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administrator has configured you with multiple note fields, you are shown a list 
of the note fields, enabling you to select a specific note field or to Add All 
Notes.  Make the appropriate selection. 

7. In the Add/Modify Note or Add/Modify Notes dialog that is displayed, specify 
the note in the appropriate field.  Note that if you had previously added a note 
to the fax in a Note field, the previously-specified note is displayed, which you 
can type over. 

If you had selected multiple fax entries, be aware that the same note is applied 
to all when you click OK.  Cancel closes the dialog without adding notes. 

8. To delete an entry from the folder, highlight the entry, right-click and select 
Delete from the shortcut menu to remove the entry.  (If appropriate, you can 
press Ctrl-A to select all faxes before selecting Delete.) 

9. To move a fax into another folder, highlight a failed fax entry, right-click and 
select Move to Folder… to display the Move fax(es) to a Folder dialog.  Choose 
the appropriate folder and click OK. 

10. To resend a failed fax (or send a saved fax), highlight the fax entry, right-click 
and select Review/Submit… from the shortcut menu to be automatically 
transferred to the Send Fax dialog.  If appropriate, make any changes to the fax 
contents/transmission information and click Send to send the fax.  

11. To resend one or more failed faxes (or send one or more saved faxes), highlight 
the fax entries, right-click and select Review/Submit… from the shortcut menu.  
When prompted whether you want to review the original transmission for each 
fax before sending, click the Review button to be automatically transferred to 
the Send Fax dialog for each fax, make your changes and click Send to send the 
fax.  Click Submit All to immediately send the faxes with the previously-
specified transmission information unchanged. 

12. To print the folder listing, right-click anywhere within the folder to display the 
shortcut menu and select Print Summary to display the Print dialog.  Click OK to 
send the list of folder contents to the selected printer. 

13. Do either of the following to print one or more Transmission Fax Reports that 
are returned to the Sent folder automatically created for a fax user account: 
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- Select one or more entries in the Sent folder and either right-click and select 

Print Details or click the Print toolbar button  to display the Print dialog.  
Click OK to send Transmission Fax Reports for the selected entries to the 
selected printer. 

- Select the Sent folder itself and click the Print toolbar button to display the 
Print dialog, with the Print range All radio button selected.  Click OK to print 
Transmission Fax Reports for all entries to the selected printer (where you will 
receive a message if the Sent folder contains more than 30 entries).   

Displaying Sent Fax Details 
• To display detailed information for the sent fax in its own window, right-click 

the appropriate entry and select Detail from the shortcut menu.  Note that you 
can execute the Delete, Move to Folder…, Print and Review/Submit… functions 
(described below) from within the Details window. 

Adding Note(s) to a Sent Fax Entry 
Add a note to one or more Sent fax entries in a Sent fax folder as follows: 

1. Open the appropriate folder, identified with the following icon  and select 
the entry/entries as follows: 

To select consecutive faxes, click the first item, press and hold down SHIFT, and 
then click the last fax. 

To select faxes that are not consecutive, press and hold down CTRL, and then 
click each fax. 

To select all faxes, press Ctrl-A. 

2. Right-click and select Add Note(s) from the shortcut menu.  If your fax service 
administrator has configured you with multiple note fields, you are shown a list 
of the note fields, enabling you to select a specific note field or to Add ALL 
Notes.  Make the appropriate selection. 

3. In the specific Note field, add a short note that describes the fax.  Note that if 
you had previously added a note to the fax, the previously-specified note is 
displayed (which you can replace). 
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If you had selected multiple fax entries, be aware that the same note is applied 
to all when you click OK.  Cancel closes the dialog without adding notes. 

Displaying Available Note Fields 
When your fax service administrator configures your use of the fax service, he/she 
can specify multiple fields in which you can add a note to a fax.  Do the following to 
display the available note fields: 

1. Right-click anywhere in the folder and select Add/Remove Columns….  A dialog 
is displayed, with a list of Available Columns and a list of Displayed Columns.   

2. To move a specific column from the Available Columns list to the Displayed 
Columns list, select the column name and click the Add button. 

To move all columns from the Available Columns list to the Displayed Columns 
list, click the Add All button. 

To delete a specific column from the Displayed Columns list, select the column 
name and click the Remove button. 

To delete all columns from the Displayed Columns list, click the Remove All 
button. 

3. To change the order in which columns are displayed (where top to bottom 
equates as left to right when the folder is opened), select the column in the 
Displayed Columns list and click the Move Up/Move Down button as 
appropriate.  Click OK. 

Deleting a Sent Fax 
You can delete a fax from a Sent fax folder, as follows: 

1. Open the appropriate folder, identified with the following icon  and select 
the entry/entries. 

2. Right-click and select Delete from the shortcut menu.  When prompted to 
confirm the deletion, click Yes to delete a single fax, Yes to All to delete all 
selected faxes, No not to delete a single fax or Cancel to exit without deleting. 
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Note:  On the Viewer/Log Options tab (Figure 1-7), you can specify whether to 
receive a message prompting you to confirm your deletions of selected faxes. 

Moving Sent Faxes to another Folder 
You can move Sent faxes to another folder as follows: 

• Open the appropriate folder, select the entry/entries, right-click and select 
Move to Folder… to display the Move to a Folder dialog.  Choose the appropriate 
Folder.  Click OK to be returned to the Sent fax folder.  Click Cancel to exit the 
dialog without moving the fax(es). 

Resending a Failed/Saved Fax 
When you specify your Transmit options, you can specify that a Return Status be 
returned for all outgoing faxes, or only for those that fail to be transmitted.  These 
Return Status messages are delivered to the Sent folder at the topmost Mailbox 
level. 

In addition, when creating a fax on the Send Fax dialog, you can save it into a folder 
or subfolder you create. 

You can then select a fax that you saved and/or that failed to be delivered (either 
from the Sent folder of Return Status messages or from another specified folder) 
and send/resend the fax, as described below. 

1. Select a fax that was saved into a specified folder on the Send Fax dialog, or one 
in the Sent folder that does not have a Status of ok, right-click and select 
Review/Submit….  You are automatically transferred to the Send Fax dialog, 
where you can send the fax as is, or with any changes you choose to make. 

2. If appropriate, select multiple faxes to resend, right-click and select 
Review/Submit…. You receive a prompt such as the following:  “You have 
selected 6 fax(es).  Click Review to review the original transmission for each fax 
before sending; click Submit All to automatically send all the fax(es).” 

If you want to be able to make changes to any of the selected faxes before 
resending, click the Review button to go to the Send Fax dialog for each fax, and 
then click the Send button to resend the fax. 
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If you want to resend the faxes automatically, without making any changes to 
any of the selected faxes, click the Submit All button. 

Printing a Sent Fax Folder Listing  
To print the Sent fax folder listing, right-click anywhere within the folder to display 
the shortcut menu and select Print to display the Print dialog.  Click OK to send the 
Sent folder to the selected printer. 

Faxing Directly from Canon MFP Devices 
The FAXCOM Client now includes the capability to fax directly from a Canon MFP 
device.  Consult with your fax service administrator to determine whether that 
function is available to you.       
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Chapter Three:  Receiving a Fax and Using Received Fax 
Folders 

Using a Received Fax Folder 
You can perform the following functions – described later in this chapter – in a 
Received fax folder – where new, unread faxes are displayed in bold: 

 

Figure 3-1.  Received Fax Folder 

Detail – display detailed information for the received fax in its own window 

Preview – view the received fax in the Viewing window 

View – view the received fax in the configured TIFF viewer  

Get Next Unread Fax – display the oldest, unread fax  
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Add Note(s) – add one or more descriptive notes to a received fax entry 

Forward – forward the fax to another network user, group, printer, or shared 
Received fax folder  

Delete – delete the received fax  

Mark as Read – specify that an unviewed fax be marked as read 

Mark as Unread – specify that a viewed fax be marked as unread; if the fax is 
marked as Unread, this function changes to Mark as Read (enabling you to 
toggle between the read/unread states) 

Print – print the contents of the Received folder 

Print Fax – print the selected fax(es) 

Send to Mail Recipient – forward one or more received faxes to an email 
recipient 

Send to Fax Recipient – be transferred to the Send Fax dialog in order to send 
the received fax 

When selecting faxes in a Received fax folder, you can use the following key 
combinations: 

Ctrl-A – to select all faxes 

Ctrl-C – to copy selected faxes 

Ctrl-V – to paste selected faxes into another folder you have opened 

Ctrl-X – to cut selected faxes (in order to paste them into another folder) 

You can view the following information: 

Viewed – either Yes or No for whether you have read the fax. 

Receive Date/Time – in the case of a fax you receive directly, the date and time 
when the phone connection was established to receive the fax, for example, 
07/03/02 02:58PM; in the case of a fax that was forwarded to you by another 
fax service user, the date and time the user forwarded the fax to you. 

Completion Date/Time – in the case of a fax you receive directly, the date and 
time when the fax server finished receiving the fax; in the case of a fax that was 
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forwarded to you by another fax service user, the date and time when the fax 
server finished receiving the fax sent to the forwarding user. 

File Name – unique identifying name assigned by the fax service, for example, 
IMFL0007 

Sender ID – Transmitting Subscriber ID (TSI) of sending fax machine (or sending 
fax number) 

Caller ID – sending fax number 

Pages – number of pages of the fax 

Size (KB) – number in kilobytes of the file where the received fax is saved 

Status – either ok (for a successfully received fax), or rdis (for a remote 
disconnect error).  It is possible that there is a page count in the Pages field, and 
yet the fax status is rdis, indicating only some of the total pages of the fax were 
received successfully. 

Note:  you can still view a fax for which only some of the pages were successfully 
received.   Moreover, if the sending fax device stamped the fax with the total 
number of pages, you can ascertain how many pages you should have received.  

Status Code – error code for the received fax.  A code of 0000 indicates the fax 
was successfully received; a code for rdis is 0052.  

Status Text – a verbal explanation of the status code, such as FAXCOM receive 
mode; disconnect requested 

Connect Time – amount of time in seconds on the phone line to transmit the fax 

DID Number – extension dialed by the remote fax device 

Fax Port – port on the FAXCOM server on which the fax was received  

Fax Server – IP address of the fax server on which the fax was received 

Notes – any descriptive notes added by the recipient (after selecting Add 
Note[s]) – for example, Insurance Quote 

• If appropriate, click the column headings to toggle between an 
ascending/descending sort. 
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• To add/remove columns, right-click anywhere in the Received fax folder and 
select Add/Remove Columns from the shortcut menu.  In the Select Columns 
dialog that is displayed, select entries in the Available Columns list and move 
them into the Displayed Columns list, either by double-clicking the entries or by 
using the Add/Add All buttons.  Remove entries from the Displayed Columns 
list, either by double-clicking the entry or using the Remove/Remove All 
buttons.  Click the Move Up/Move Down buttons as appropriate to cause the 
entry to move to the left-hand/right-hand side of the Received fax folder.  Click 
OK to be returned to the Received fax folder with your selections enabled. 

Displaying Received Fax Details 
• To display detailed information for the received fax in its own window, right-

click the appropriate entry and select Details from the shortcut menu. 

Viewing a Received Fax 
You can view a received fax in two ways: 

• Display it in the Viewing Pane without opening it 

• Open the fax in the configured fax viewer, as described below. 

1. Open the appropriate Received Fax folder, identified with . 

2. Either double-click the entry to view (or highlight the entry and select View from 
the shortcut menu.  The fax is then displayed with the configured default 
viewer.  (If you have not specified your default viewer program, you will be 
prompted to specify [or browse through your file listing for] the viewer program 
with which to open the fax.)  

3. Use the viewer to manipulate the fax image and perform additional functions on 
the received fax (as described in Chapter Five). 

Note:  Users of Shared Received fax folders should be aware that since multiple 
users can open the same fax in FAXCOM Viewer and make changes (such as adding 
text), you may receive a prompt when saving the fax in FAXCOM Viewer that 
another user has made changes which your changes will overwrite.  
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Getting the Next Unread Fax 
Do the following to view the oldest, unread fax – where new unread faxes are 
displayed in bold: 

• Either click the  toolbar button or right-click anywhere in the folder and 
select Get Next Unread Fax from the shortcut menu. 

Adding Note(s) to a Received Fax Entry 
Add note(s) to one or more received fax entries in a Received fax folder as follows: 

1. Open the appropriate folder, identified with the following icon . 

2. Select the entry/entries as follows: 

To select consecutive faxes, click the first item, press and hold down SHIFT, and 
then click the last fax. 

To select faxes that are not consecutive, press and hold down CTRL, and then 
click each fax. 

To select all faxes, press Ctrl-A. 

3. Right-click and select Add Note(s) from the shortcut menu.  If your fax service 
administrator has configured you with multiple note fields, you are shown a list 
of the note fields, enabling you to select a specific note field or to Add All 
Notes.  Make the appropriate selection. 

4. In the Add/Modify Note or Add/Modify Notes dialog that is displayed, specify 
the note in the appropriate field.  Note that if you had previously added a note 
to the fax in a Note field, the previously-specified note is displayed, which you 
can type over. 

If you had selected multiple fax entries, be aware that the same note is applied 
to all when you click OK.  Cancel closes the dialog without adding notes. 
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Displaying Available Note Fields 
When your fax service administrator configures your use of the fax service, he/she 
can specify multiple fields in which you can add a note to a fax.  Do the following to 
display the available note fields: 

1. Right-click anywhere in the folder and select Add/Remove Columns….  A dialog 
is displayed, with a list of Available Columns and a list of Displayed Columns.   

2. To move a specific column from the Available Columns list to the Displayed 
Columns list, select the column name and click the Add button. 

To move all columns from the Available Columns list to the Displayed Columns 
list, click the Add All button. 

To delete a specific column from the Displayed Columns list, select the column 
name and click the Remove button. 

To delete all columns from the Displayed Columns list, click the Remove All 
button. 

3. To change the order in which columns are displayed (where top to bottom 
equates as left to right when the folder is opened), select the column in the 
Displayed Columns list and click the Move Up/Move Down button as 
appropriate.  Click OK. 

Forwarding a Received Fax to Another Network User, Group, 
Printer, or Shared Received Fax Folder 
Do the following to forward a received fax from a Received fax folder – without 
having to open up the fax and view it: 

1. From a Received fax folder, highlight the fax entry to forward, right-click and 
select Forward from the shortcut menu to display the Forward Fax dialog (Figure 
3-2). 
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Figure 3-2.  Forward Fax Dialog 

The fax service users, groups, printers, and shared Received fax folders to 
which you can forward the fax are organized in three containers, Recent, 
Frequent, and Browse, where 

Recent – contains the most recent items to which you forwarded faxes 

Frequent – contains the items specified by the fax service administrator 

Browse – opens a network listing from which you can select the appropriate 
user/group/printer/shared folder 

2. In the List of Users, highlight the item to which to forward the fax, and click the 
Add button to move it to the Forward To list.  (To remove an item from the 
Forward To list, select the entry and click the Remove button.) 

3. To delete the forwarded fax from the Received fax folder, check the Delete fax 
after forward check box. 

4. Click Forward to forward the fax to the selected items.  Click Cancel to exit 
without forwarding the fax. 
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Deleting a Received Fax 
You can delete a fax from a Received fax folder that you received directly or had 
forwarded to you. 

1. Open the appropriate folder, identified with the following icon  and select 
the entry/entries. 

2. Right-click and select Delete from the shortcut menu.  If the fax has been 
viewed, it is deleted from the folder.  If the fax has not been viewed, you are 
prompted whether you want to delete it.  Click OK to delete or Cancel to exit 
without deleting. 

Note:  On the Viewer/Log Options tab (Figure 1-7), you can specify whether to 
receive a message prompting you to confirm your deletions of selected faxes. 

Mark as Read/Unread 
• To specify that a viewed fax be marked as Unread, right-click a viewed fax and 

select Mark as Unread from the shortcut menu; to specify that an unviewed fax 
be marked as Read, right-click an unviewed fax and select Mark as Read from 
the shortcut menu. 

Printing the Received Fax Folder Listing 
• To print the Received fax folder listing, right-click anywhere within the folder to 

display the shortcut menu and select Print to display the Print dialog.  Click OK 
to send the Received fax folder to the selected printer. 

Printing Faxes 
• To print the faxes themselves, select the faxes to be printed, right-click and 

select Print Fax to display the Print dialog.  Click OK to send the selected faxes 
to the selected printer. 

Sending a Received Fax to an email Recipient 

Do the following to send a received fax to an email recipient: 
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1. Within the specific folder, select the faxes to be sent to an email recipient, as 
follows: 

To select consecutive faxes, click the first item, press and hold down SHIFT, 
and then click the last fax. 

To select faxes that are not consecutive, press and hold down CTRL, and 
then click each item. 

To select all faxes, press Ctrl-A. 

2. Right-click and select Send to Mail Recipient from the shortcut menu.  You are 
automatically transferred to your email application New Message window, with 
each selected fax shown as an attachment icon. 

3. Proceed to address and send the message with the attached fax(es), as you do 
with any email message. 

Sending a Received Fax to a Fax Recipient 
Do the following to send a received fax to a fax recipient: 

1. Within the specific folder, select the faxes to be sent to a fax recipient, right-
click and select Send to Fax Recipient from the shortcut menu.  You are 
automatically transferred to the Send Fax dialog, with each selected fax listed in 
the Attachment list. 

2. Proceed to address and send the fax.
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Chapter Four:  Using Share Rights to another User Account 
You may be configured to access the faxes in the account of another fax service 
user.  Just what fax functions you can perform in the shared user account depends 
on the specific permissions granted you by the fax service administrator, where the 
following permissions are available: 

Read – read-only access to the faxes and return status messages for transmitted 
faxes  

Delete – capability to delete faxes and return status messages for transmitted 
faxes; being granted the Delete permission automatically grants you Read and 
Write permissions 

Send As – capability to send faxes as the user account being shared; being 
granted the Send As permission automatically grants you the Read permission.  
While the Send As permission enables viewing of phonebooks and FAXCOM 
Client options in the shared account, it does not enable you to make changes to 
phonebooks and options.  

Write – capability to do the following:  modify notes added to faxes; copy faxes 
(and return status messages for transmitted faxes) between folders/subfolders; 
create subfolders; annotate faxes being viewed in FAXCOM Viewer.  Being 
granted the Write permission automatically grants you the Read permission. 

Archive – enables you to run the FAXCOM Client, select a folder/subfolder to 
which you have been given access, right-click and select Send to Archive… and 
archive faxes. 

Specify Permissions – enables you to run the FAXCOM Client, select a user 
account to which you have been given access, right-click, select Share Rights…, 
and specify user account permissions (which cannot be greater than those you 
yourself were granted).  When your fax service administrator grants you the 
Specify Permissions capability, he/she can specify that any permissions you 
specify for the shared user account cannot override the permissions set by the 
administrator for this user.  

If you do not have Share Rights to any other user accounts, none are displayed in 
your FAXCOM Client folder listing.  Figure 4-1 shows the FAXCOM Client of a user 
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with Share Rights access to an additional user account, TestUser1.  Note the 
difference in the folder icons for shared and unshared user accounts: 

Unshared Received fax folder:   

Unshared Sent fax folder:   

Shared Received fax folder:   

Shared Sent fax folder:   

 

Figure 4-1.  FAXCOM Client with Access to an Additional User Account 

Specifying Permissions 
If your fax service administrator has given you Specify Permissions access to the 
shared user account, do the following to implement the access: 

1. Select a user account in the folder listing, right-click and select Share Rights… 
to display the Accounts Rights dialog (Figure 3-2), with a list of users previously 
granted Share Rights to this user account. 
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Figure 4-2.  Account Rights Dialog 

2. To grant another user Share Rights to the user account, click the Add button, 
select a user from the displayed list, and click OK to be returned to the Account 
Rights dialog. 

3. To remove a user from having Share Rights to the user account, select the user 
and click the Remove button.  When prompted to confirm the deletion, click Yes. 

4. To specify/modify Share Rights for a user, select the user to enable the 
Permissions check boxes.  Note that the specific check boxes that are enabled 
depend on the following: 
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• The specific permissions you have been granted to this user account – since 
you cannot specify permissions greater than those granted you 

• Whether or not the fax service administrator has specified that any 
permissions you grant cannot override the permissions previously set by the 
administrator for this user account. 

5. As appropriate, check/uncheck the enabled permissions and click OK.  
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Chapter Five:  Using FAXCOM Viewer 

Working With Documents 
Once you invoke FAXCOM Viewer, you can create and open additional documents, 
and even overlap two documents. 

This section describes the basic procedures for working with document files.  

Creating a New Blank Document 

Either click , or on the File menu click New. 

A blank TIFF image document, called Unnamed, is displayed in a new window. 

Opening a Document 

1. Either click , or on the File menu click Open to open an existing TIFF image 
document. 

2. In the Look In box, click the location of the document. 

3. In the area below the Look In box, double-click the appropriate folder. 

4. Double-click the document name to open it (or type the name in the File Name 
box). 

Closing a Document 

1. Either click , or from the File menu click Close. 

If you have made changes to the document, you are prompted whether to save 
the changes. 

2. Click Yes or No as appropriate. 

If you have used any of the Annotation tools (except the Text tool) to make 
changes, you are prompted whether you want to merge the annotations with the 
original image). 
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3. Click Yes to make the annotations permanent by fusing them to the page; click 
No if you do not wish to retain any lines or highlighting you have added. 

Text you have input is automatically saved and merged. 

4. Click Yes to make the annotations permanent by fusing them to the page; click 
No to close the document without retaining the annotations. 

Getting the Next Unread Fax 
When you access FAXCOM Viewer from a Received fax folder, you have the 
capability to view the next unread fax without having to be returned to the folder.  
(When you access the FAXCOM Viewer as a standalone application [not from a 
Received fax folder] this capability is unavailable.) 

Do the following to view the next unread fax in a Received fax folder: 

1. After opening the FAXCOM Viewer from a Received fax folder and while viewing 

a fax, either click  or click Get Next Unread Fax on the File menu. 

The next unread fax is opened, and becomes the active window.  If you then 
return to the previously-viewed fax (by making it the active window) and 
attempt to close it after having made a change (such as an annotation), you are 
prompted whether to save the changes before closing the document. 

2. Continue the process of clicking  or clicking Get Next Unread Fax on the 
File menu. 

When you reach the last of the unread faxes, a message is displayed informing 
you that there are no more unread faxes to view.   

Faxing and Forwarding a Document 
While you are viewing a fax, you can fax it to any specified fax recipient(s), as well 
as forward it to other fax service users. 



 

51 

To fax the document: 

1. To send a fax of the image you are currently viewing, either click  or on 
the File menu click Send Fax. 

In full-page view, you are prompted to specify whether to send all pages in the 
document, or to enter a specific page range to be sent. 

In thumbnail view, you are prompted to specify whether to send all pages in the 
document, to send selected pages, or to enter a specific page range to be sent. 

2. Select the appropriate option and click OK to be automatically transferred to the 
FAXCOM Client Send Fax dialog in order to address the fax, specify transmission 
options, create a cover page memo, save the fax in a folder, etc.  If necessary, 
access the online help available from the Send Fax dialog to guide you in 
sending the fax. 

To forward the document to another fax service user: 

1. Either click  or click Forward Fax on the File menu. 

The Forward Fax dialog is displayed (Figure 3-2). 

2. Follow the instructions in the “Forwarding a Received Fax to Another Network 
User, Group, Printer or Shared Received Fax Folder” section in Chapter Three to 
forward the fax. 

To forward the fax to an email recipient: 

1. Either click  or select Send to Mail Recipient from the File menu, or right-
click and select Send Fax to Mail Recipient from the shortcut menu. 

You are automatically transferred to your email application New Message 
window with an attachment icon for the fax. 

2. Address and send the fax as you would any email message. 

Adding a Note to a Fax 
While viewing a received fax, you can add a descriptive note to the fax that will be 
displayed in the Received fax folder containing the fax. 
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1. Either click  or click Add Fax Note on the File menu. 

2. In the Fax Note box that is displayed, add a short (40 characters maximum) note 
that describes the fax and click OK.  (Note that if you had previously added a 
note to the fax, the previously-specified note is displayed.  To change the 
original note, type over it with the new note and click OK. 

Releasing a Fax 
When you check the Preview check box on the Send Fax dialog (Figure 2-1) you are 
able to preview the fax before it is actually transmitted.  You then preview the fax 
by accessing the Pending Queue, selecting the appropriate fax entry, and, when the 
Status displays Ready for PREVIEW, right-clicking and selecting Preview from the 
shortcut menu to display the fax in FAXCOM Viewer. 

Once you have previewed the fax, you release it for transmission by selecting 
File…Release Fax on the File menu. 

Renaming a Document 
1. On the File menu click Save As. 

The Save as dialog is displayed. 

2. To save the file in a new location, enter the location in the Save in box; to 
rename the document, enter the new name in the File name box. 

3. Click the Save button. 

Reversing the Previous Action 

• Either click , or on the Edit menu click Undo. 

(The Undo function is grayed out if the most recent action cannot be reversed.) 

Saving Changes to a Document 

1. Either click , or on the File menu click Save.  All pages of the document are 
automatically saved. 
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2. If you have used any of the Annotation tools (except the Text tool) to make 
changes, you are prompted whether you want to merge the annotations with the 
original image). 

3. Click Yes to make the annotations permanent by fusing them to the page; click 
No to retain the annotations as an overlay on the original image that can still be 
modified (resized, copied, moved, etc.). 

Text you have input is automatically saved and merged. 

If you are in Thumbnail mode, you are prompted whether to save all pages, save 
the selected pages, or save the page range you specify.  

4. Select the appropriate radio button and click OK.  

5. To be able to assign a new name to a document, or save it in another file 
location, click Save As (rather than Save) and enter the new name in the File 
name box, and the new location in the Save in box. 

Launching an External Application 
1. On the File menu click Run External Application to be able to launch an 

application external to the FAXCOM Viewer – such as an Optical Character 
Recognition (OCR) program. 

The Run external application box is displayed, prompting you for which external 
application to run, and informing you that the document you are currently 
viewing in FAXCOM Viewer has been saved as C:\TEMP\currimgs.tif. 

2. Either enter the path to the external application in the External application 
pathname field, or click the Browse button to display the Open box and select 
the file to open.  Click the Run button to launch the application. 

If you have launched an OCR program, you can then open the document you are 
currently viewing, saved as C:\TEMP\currimgs.tif, to perform OCR on it. 

Showing/Hiding the Status Bar 
The status bar is a horizontal area below the image window that provides 
information about the current state of what you are viewing in the window, such as 
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the function of a toolbar button, page count, page currently displayed and 
annotation tool in use.  

1. To show the Status Bar, on the View menu click Show Status bar. 

A checkmark is displayed next to the command to indicate the toolbox is 
displayed. 

2. To hide the Status Bar, on the View menu click Show Status bar (when a 
checkmark is displayed next to the command). 

A checkmark is no longer displayed next to the command to indicate the status 
bar is not displayed. 

Showing/Hiding the Toolbar 
In addition to the standard Windows buttons (such as New, Open, Save, Print, Cut, 
Copy, Paste, etc.), the Toolbar includes buttons you click to select an area, rotate 
the image, display a thumbnail image of all pages, go to previous/next page, zoom 
the image, touch up the image, erase, scan, and send a fax.    

1. To show the Toolbar, on the View menu click Show Toolbar. 

A checkmark is displayed next to the command to indicate the Toolbar is 
displayed. 

2. To hide the Toolbar, on the View menu click Show Toolbar (when a checkmark is 
displayed next to the command). 

A checkmark is no longer displayed next to the command to indicate the 
Toolbar is not displayed. 

Showing/Hiding the Annotation Toolbar 
The Annotation toolbar includes buttons you click to insert text, draw lines and 
curves, highlight a rectangular area and select the color for your annotations.  

1. To show the Annotation toolbar, on the View menu click Show Annotation 
Toolbar. 

A checkmark is displayed next to the command to indicate the toolbar is 
displayed. 
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2. To hide the Annotation toolbar, on the View menu click Show Annotation 
Toolbar (when a checkmark is displayed next to the command). 

A checkmark is no longer displayed next to the command to indicate the toolbar 
is not displayed. 

Overlapping Background and Foreground 
You can open multiple documents in FAXCOM Viewer and then specify one as the 
foreground and one as the background.  You can then process the foreground 
image without affecting the background image. 

Note:  You can also overlap two pages in one document, and even overlap a page 
on itself.  

1. Open one or more documents. 

2. On the Window menu, click either Tile Horizontally or Tile Vertically to display 
all open documents simultaneously. 

3. On the Process menu, click Overlap. 

4. With one of the documents selected as the active document, in the Overlapping 
dialog click the appropriate button:  either Foreground or Background. 

5. Click another of the documents to make it the active document, and in the 
Overlapping dialog click the other button, i.e., if you clicked Foreground for the 
first document, click Background for the second; if you clicked Background for 
the first document, click Foreground for the second. 

The Overlapping dialog automatically closes. 

6. Maximize the document with the overlapping images, and work with it as 
appropriate. 

7. To move the foreground image over the background image, on the Process 
menu click Shift Foreground.  Specify the number of pixels to move the image 
and the direction (Up, Down, Left, Right), and click OK to move the image the 
specified amount and direction. 

8. To end the Overlap function, on the Process menu, click Finish Overlap.   
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Shifting the Foreground 

When you are overlapping one document onto another, you can move the 
foreground image by specifying the amount to move it and the direction. 

1. With one image overlapping another, on the Process menu click Shift 
Foreground. 

2. In the box that is displayed, specify the number of pixels to move the image and 
the direction (Up, Down, Left, Right) and click OK. 

Scanning and Printing 
The following sections explain how you can invoke scanning functions within 
FAXCOM Viewer, in addition to printing the displayed image.  

Scanning a Page 
If you have a TWAIN-compatible scanner connected to your PC, and have installed 
the correct TWAIN drivers for your PC operating system, you can launch your 
scanner application from FAXCOM Viewer to automatically insert a scanned page in 
your document, as follows: 

1. With a page inserted in the scanner sheet feeder (top edge down, printed side 

away from you), either click  or on the File menu click Scan…Start Scan. 

2. Follow the instructions on the screen, referring to your scanner documentation 
if necessary. 

Once the page is scanned and ejected, you are returned to FAXCOM Viewer with 
the scanned page displayed as part of the document. 

3. Use any of the FAXCOM Viewer capabilities to work with the scanned image.  (If 
the image is displayed with white text on a black background, on the Process 
menu click Invert.)  

Printing a Document 

1. Either click , or on the File menu click Print. 
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2. In the Print box, specify whether to print all pages in the document or a 
specified page range only.  Click OK. 

Working with Pages 
The following sections explain how the functions by which you can manipulate 
pages in the document being viewed. 

Changing the Page Fit 

1. To fit the page width to the window, either click , or on the Zoom menu 
click Fit Width. 

2. To fit the page length to the window, on the Zoom menu click Fit Length. 

3. To fit the entire page length in the window, on the Zoom menu click Fit Best. 

(Unlike Fit Length, whereby the page length is cut off when the window is 
reduced in size, Fit Best maintains the entire page length when the window is 
reduced in size. 

4. To restore the page to its original size, on the Zoom menu click Original Size. 

Changing the Page Order 
When you are viewing all pages in Thumbnail mode, you can change the order of 
the pages within the document, as follows: 

1. In Thumbnail mode, on the View menu click Set Page Order to display each page 
with a number indicating its page order within the total number of pages. 

2. Click each page to change its order within the document.  

Copying a Page 
When you are viewing all pages in Thumbnail mode, you can copy a page, as 
follows: 

1. To copy a single page, in Thumbnail mode, click a page and on the Edit menu 
click Copy Page. 
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2. To copy multiple pages, in Thumbnail mode, on the Edit menu first click Stack, 
stack the pages, click the stack and on the Edit menu click Copy Page.  

3. To insert the copied page/copied stack within the current document, on the Edit 
menu click Insert Page. 

Deleting a Page 
When you are viewing all pages in Thumbnail mode, you can delete a page (or stack 
of pages) and insert it in the current document, as follows: 

1. To delete a single page, in Thumbnail mode, click a page and on the Edit menu 
click Delete Page. 

2. To delete multiple pages, in Thumbnail mode, on the Edit menu first click Stack, 
stack the pages, click the stack and on the Edit menu click Delete Page.  

Displaying a Document in Thumbnails 

1. To display all pages in a document, either click , on the View menu click 
View All Pages, or double-click a page displayed in full-screen mode. 

2. To exit Thumbnail mode, either double-click any of the displayed pages, or 

click Previous  or Next . 

Going to the Next/Previous Page 

1. To display the previous page, either click Previous , or on the View menu 
click Previous. 

2. To display the next page, either click Next , or on the View menu click Next. 

Going to the First/Last Page 
1. To display the first page, on the View menu click First Page. 

2. To display the last page, on the View menu click Last Page. 
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Going to a Specified Page 
1. To display a specific page, on the View menu click Go to Page. 

2. In the box that is displayed, click the specific page in the list and click OK. 

Inverting Background and Foreground Colors 
• On the Process menu, click Invert to cause a white background to be changed to 

black and black text to be changed to white (and vice versa).  

Inserting a Page 
When you are viewing all pages in Thumbnail mode, you can copy a page (or stack 
of pages) and insert it in the current document, as follows: 

1. To copy a single page, in Thumbnail mode, click a page and on the Edit menu 
click Copy Page. 

2. To copy multiple pages, in Thumbnail mode, on the Edit menu first click Stack, 
stack the pages, click the stack and on the Edit menu click Copy Page.  

3. To insert the copied page/copied stack within the current document, on the Edit 
menu click Insert Page. 

Rotating a Page 
To rotate a page 90° clockwise, you can either use a toolbar button or you can 
select the function from the Process menu. 

Additional rotation functions are available from the Process menu. 

1. To rotate a page 90° clockwise, either click , or on the Process menu, click 
Rotate 90° CW. 

2. To rotate a page 90° counter clockwise, on the Process menu, click Rotate 90° 
CCW. 

3. To rotate a page 180°, on the Process menu, click Rotate 180°. 
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4. To rotate to a horizontal line, on the Process menu, click Rotate to Horz-line.  
Draw the horizontal line and then click with the mouse.  The page is rotated to 
the angle of the horizontal line you drew.  

5. To rotate to a vertical line, on the Process menu, click Rotate to Vert-line.  Draw 
the vertical line and then click with the mouse.  The page is rotated to the angle 
of the vertical line you drew 

6. To rotate to a specified angle, on the Process menu, click Rotate Any Angle.  
You are prompted to specify the angle in the Enter a rotating angle box.  Specify 
the angle and click OK to rotate the page to the specified angle. 

Stacking/Unstacking Pages 
When you are viewing all pages in Thumbnail mode, you can stack a group of pages 
and then be able to copy/insert/delete all pages in the stack, as follows: 

1. To stack all pages in their current page order, in Thumbnail mode, select all 
pages by holding down the shift key while you click each page. 

2. Either click , or on the Edit menu click Stack.  The pages are stacked 
automatically. 

3. To stack specified pages in a specified order, in Thumbnail mode, click one 

page and then either click , or on the Edit menu click Stack. 

4. As appropriate, click and drag any page and place it on top of any other page. 

5. To unstack a stack of pages, either click Unstack , or on the Edit menu click 
Unstack. 

Splitting a Multi-Page Fax 
You can split a multi-page fax into separate, multiple faxes by doing the following: 

1. To separate the fax into two faxes, one from the pages before the currently-
viewed page and one from all pages forward, including the currently-viewed 

page, on the current page, either click  or select Split Here on the Edit 
menu.  The fax is then split into two separate faxes. 
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2. To access additional options for splitting the fax, select Split…on the Edit menu. 

3. In the dialog that is displayed, select the appropriate option and click OK, where 

All – splits the fax into individual pages.  For example, selecting All for a 10-
page fax results in 10 separate faxes. 

Current Page – separates the fax into two faxes, one from the pages before the 
currently-viewed page and one from all pages forward, including the currently-
viewed page. 

Pages – enables you to specify individual pages or a range of pages to be split 
off from the fax.  For example, specifying 7 in a 10-page fax results in page 7 
being removed as a separate fax.  Specifying 3-7 in a 10-page fax results in 
pages 3 through 7 being removed as a separate fax. 

Manipulating an Image 
The following section describes how you can manipulate an image by enlarging or 
reducing the image.  

Zooming an Image 

1. To enlarge the image by 10%, either click Expand , or on the Zoom menu 
click Expand. 

2. To reduce the image by 10%, either click Reduce , or on the Zoom menu 
click Reduce. 

3. To return the image to its original size, on the Zoom menu click Original Size. 

Working with Selected Areas of a Page 
The following sections describe how you can manipulate a portion of a displayed 
image. 

Copying and Moving Page Elements 
You can select an element of a page and then copy it or move it. 
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1. On the Edit menu, click Select. 

2. In the document window, press the left mouse button and drag the mouse to 
drag the selection window around the page element.  Release the mouse button 
to display a shorthand menu. 

3. Make the appropriate selection. 

4. If you selected Copy, on the Edit menu, click Paste.  Drag the selection to the 
desired location and click the left mouse button to position the element. 

If you selected Move, drag the selection to the desired location and click the left 
mouse button to position the element. 

Erasing an Image Area 
To clear the area of the image over which you drag an eraser, you can either use a 
toolbar button or you can select the function from the Process menu. 

Additional eraser functions are available from the Process menu. 

1. To clear the area of the image over which you drag an eraser, either click  or 
on the Process menu click Eraser.  Hold down the left mouse button and drag 
the mouse to erase the area below the eraser.  Click the right mouse button to 
end the eraser mode. 

2. To draw a rectangular area to be erased, on the Process menu click Erase in 
Rectangle.  Hold down the left mouse button and drag the mouse to define the 
rectangular area.  Release the button to erase the part of the image enclosed in 
the rectangle. 

3. To draw an area within a polygon to be erased, on the Process menu click Erase 
in Polygon.  Hold down the left mouse button and drag the mouse to define the 
polygon.  Double-click the button to erase the part of the image enclosed in the 
polygon. 

Note:  If you erase an area and then immediately decide you want to retain the 
erased area, on the Edit menu click Undo.  Or, if you decide later in the editing 
process to retain the erased area, when you close the file and are prompted if you 
want to save the changes, click No.   
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Saving a Partial Image 

1. Either click , or on the Edit menu click Select to define a rectangular area. 

2. Either select Save Image from the shortcut menu that is displayed, or from the 
File menu click Save Partial Image. 

3. In the Save As dialog that is displayed, enter the name for the new image 
document in the File name box, and its location in the Save in box. 

Manipulating an Area of a Page 

1. To define a rectangular area of a page, either click , or on the Edit menu 
click Select. 

Drag the selection tool to define the area and display a shortcut menu with the 
following functions: 

Fit to Window – fits the width of the defined area to the window   

Cut – removes the defined area 

Copy – copies the defined area  

Move – lets you drag the defined area and then click to position it in another 
location  

Zoom – lets you resize the defined area by dragging its selection handles and 
endpoints (function also available when you click Zoom on the Edit menu) 

Save Image – displays the Save As dialog in order to save the defined area as a 
new file (a function also available when you click Save Partial Image on the File 
menu) 

Touching up an Image 

1. To edit a portion of the image displayed in FAXCOM Viewer, either click  or 
on the Process menu click Touch Up. 

2. Position the selection box over the portion of the image to be zoomed and click 
with the left mouse button to zoom the selected portion of the image. 
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3. As appropriate, click the mouse in a square of the zoomed image grid to clean 
up the image – either by adding black or removing black from a square. 

4. When done, click the Close button to close the zoomed portion of the image.     

Working with Annotations 
The following sections explain how you can add text, lines and highlighting to a 
document being viewed. 

Annotating a Document 
On the Annotate menu, or from the Annotation toolbar, you can click any of the 
following functions to:  

    select your annotation (to move, modify or remove it) 

    add text 

    draw straight lines 

    draw curved lines (also called Freehand) 

    draw a line ending with an arrowhead 

    draw a line beginning and ending with an arrowhead 

    draw a line that branches off at different angles 

    highlight a rectangular area 

  delete a selected annotation 

   select line thickness 

   select the color of annotations 

Refer to the “Showing/Hiding the Annotation Toolbar” section earlier in this 
chapter for instructions for displaying the toolbar.  
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Selecting an Annotation 
In order to move, modify, or remove an annotation, you must first select it, as 
follows: 

1. Either click , or on the Annotate menu click Pick Up. 

2. Click the annotation (i.e., lines or text you have entered). 

3. As appropriate, drag the annotation to move it, modify it (by changing the color 
and thickness of lines, and the font, size and style of text), press Delete to 
remove it. 

Modifying an Annotation 
You can modify a line you have added by changing its color and thickness.  You can 
modify text you have added (by changing its font, size and style), as follows: 

1. Select the annotation, either by clicking , or on the Annotate menu clicking 
Pick Up. 

2. Click the annotation (i.e., lines or text you have entered). 

3. To change the thickness of a line, either click Thickness  , or on 
the Annotate menu click Change Line Thickness. 

4. To change the font size and style of text, either click Font Size 

, or on the Annotate menu click Change Font. 

5. To change the color of lines and text, either click Color , or on the 
Annotate menu click Change Color. 

Making Annotations Permanent 

1. Either click , or on the File menu click Save. 

2. If you have used any of the Annotation tools (except the Text tool) to make 
changes, you are prompted whether you want to merge the annotations with the 
original image. 
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3. Click Yes to make the annotations permanent by fusing them to the page; click 
No to retain the annotations as an overlay on the original image that can still be 
modified (resized, copied, moved, etc.). 

Text you have input is automatically saved and merged. 

4. To be able to assign a new name to a document, or save it in another file 
location, click Save As (rather than Save) and enter the new name in the File 
name box, and the new location in the Save in box. 

Merging Annotations 
When you attempt to save a document, and have used any of the Annotation tools 
(except the Text tool) to make changes, you are prompted whether you want to 
merge the annotations with the original image). 

Click Yes to make the annotations permanent by fusing them to the page; click No 
to retain the annotations as an overlay on the original image that can still be 
modified (resized, copied, moved, etc.). 

Text you have input is automatically saved and merged. 

Adding Text 

1. To add text to a document, either click Text , or on the Annotate menu click 
Text. 

2. To specify the font size and style, either click Font Size 

, or on the Annotate menu, click Change Font and 
make your selections. 

To specify the font color, either click Color , or on the Annotate 
menu, click Change Color and make your selection. 

3. Type your text, and either click Pick Up , or on the Annotate menu click Pick 
Up to select it and apply your color selection. 

4. Click the text. 
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5. To change the font size and style, either click Font Size 

, or on the Annotate menu, click Change Font and 
make your selections. 

To change the font color, either click Color , or on the Annotate 
menu, click Change Color and make your selection. 

6. To move or remove the text, either click Pick Up , or on the Annotate menu 
click Pick Up. 

7. Click the text you have entered. 

8. As appropriate, drag the text to move it or press Delete to remove it. 

Drawing Lines 

1. To draw a straight line, either click Line  or on the Annotate menu click Line. 

To draw a line with one arrow, either click 1-Arrow Line  or on the Annotate 
menu click Line with 1 Arrow. 

To draw a line with two arrows, either click 2-Arrow Line , or on the 
Annotate menu, click Line with 2 Arrows. 

To draw a curved line (also referred to as free hand), either click Free Hand , 
or on the Annotate menu click Free Hand. 

To draw a line that branches at an angle, either click Polyline , or on the 
Annotate menu click Polyline. 

2. To specify the line width and color, either click Color , or on the 
Annotate menu click Change Color. 

3. To move or remove the line, either click Pick Up , or on the Annotate menu 
click Pick Up. 

4. Click the line. 

5. As appropriate, drag the line to move it or press Delete to remove it. 
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Drawing a Free Hand Line 

1. To draw a curved line (also referred to as free hand), either click , or on the 
Annotate menu click Free Hand. 

2. To specify the line width and color, either click Color , or on the 
Annotate menu click Change Color. 

3. To move or remove the line, either click , or on the Annotate menu click Pick 
Up. 

4. Click the line. 

5. As appropriate, drag the line to move it or press Delete to remove it. 

Drawing a Filled Rectangle 
Highlighting a rectangular area draws a filled rectangle, as follows: 

1. Either click Highlit, or on the Annotate menu, click Highlight. 

2. To specify the highlight color, either click , or on the Annotate 
menu, click Change Color and make your selection. 

Highlighting an Area 

1. To highlight a rectangular area, either click , or on the Annotate menu, click 
Highlight. 

2. To specify the highlight color, either click , or on the Annotate menu, 
click Change Color and make your selection.  

Note:  Yellow is the recommended color for highlighting. 
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Deleting an Object 

To remove a selected annotation, either click , or on the Annotate menu click 

Pick Up.  Press the Delete key.  You can also click , or on the Annotate menu 

click Pick Up, then click Delete Object . 

Using a Rubber Stamp Annotation 
The Rubber Stamp function enables you to stamp the image with a previously-
created Bitmap or TIFF file.  You can also include the date and/or time as part of the 
stamped image. 

1. On the Annotate menu, select Stamp. 

2. Click the Browse button and select the stamp file (.bmp or .tif) from your file 
listing and be returned to the Select a Stamp dialog. 

Note:  Even though the stamp will be displayed as a black and white image, you can 
select a color image as long as it contains less than 256 colors.   

3. To add the current date to the selected stamp file, click the Font button to select 
the appropriate font style and size, then click the Date button; click the left 
mouse button to position the date on the stamp image preview, then click OK.  

4. To add the current time to the selected stamp file, click the Font button to 
select the appropriate font style and size, then click the Time button; click the 
left mouse button to position the time on the stamp image preview, then click 
OK.  

5. To add only the selected stamp file, click OK. 

6. Position the stamp frame where you want it and then click the left mouse button 
to fix it in place.
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Chapter Six:  Using the Pending Queue and Viewing the 
Activity Log 
Note:  You can specify whether the FAXCOM Client displays or hides the Pending 

Queue and/or Activity Log, as follows:  either click the Options toolbar button  
and select Viewer/Log Options or select Tools…Options…Viewer/Log Options.  In 
the Display Options box, select the Pending Queue and/or Activity Log checkbox to 
display the Pending Queue/Activity Log; clear the boxes to hide the Pending 
Queue/Activity Log.  Click OK. 

Using the Pending Queue 
The Pending Queue lists all faxes queued for transmission and enables you to see 
what place your jobs occupy in the queue.  You can select your own jobs and make 
last-minute changes to their transmission status and destination fax number.  
When selecting faxes, you can use Ctrl-A to select all faxes. 

If you checked the Preview checkbox on the Send Fax dialog when sending the fax, 
you can also preview the outgoing fax from the Pending Queue. 

Do the following to access and use the Pending Queue: 

1. Either select Logs…Pending Queue or click the Pending Queue item  in the 
Folder list to display the Pending Queue (Figure 6-1). 
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Figure 6-1.  Pending Queue 

2. View the following information: 

Job ID – 4-digit number used to track a fax 

Unique ID 

Date/Time – when the fax is to be transmitted 

Priority – specified for transmission 

Sender – name of the originator of the fax 

Number – destination fax number 

Attempts – number of transmission attempts already executed 

Status – condition of the fax, either 

Ready – to be delivered to the fax server 

Active – already delivered to the fax server 

Hold – kept from being delivered to the fax server.  If you put an Active job 
on hold, the Status is indicated as ACT/HLD, and further retries are 
prevented after the current transmission attempt concludes. 
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If you chose to preview the message before sending, the following additional 
status conditions apply: 

Submitting PREVIEW 

Preparing PREVIEW 

Ready for PREVIEW 

3. If appropriate, click the column headings to toggle between an 
ascending/descending sort. 

4. To add/remove columns, right-click anywhere in the Pending Queue and select 
Add/Remove Columns from the shortcut menu; in the Select Columns dialog 
that is displayed, select the Display Selected Columns radio button, then 
check/uncheck the specific columns to add/remove.  Click OK to be returned to 
the Pending Queue with your selections enabled. 

5. If desired, right-click and select Only User’s Faxes from the shortcut menu to 
display only your jobs. 

If appropriate, right-click and select Other User’s Faxes from the shortcut menu 
to select other user accounts to which you have been given Share Rights.  

If appropriate, right-click and select Faxes to Authorize Only if you have been 
configured by the fax service administrator to authorize outgoing faxes sent by 
others. 

6. To change the destination fax number, transmission priority or the time of 
transmission, highlight an entry and right-click to display the shortcut menu; 
select Change. 

If you selected a single entry: 

In the Change Pending Entry box that is displayed, enter the new number.  Click 
the appropriate Schedule button.  If you selected Delay, enter the date and time 
of the delayed transmission. 

In the Priority box, select another priority from the choices available to you. 

Click OK to be returned to the Pending Queue with the entry changed. 

If you selected multiple entries: 
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Be aware that the changes you make to Schedule and Priority apply to all 
selected faxes.  You can, however, select the No Change radio button to retain 
the original scheduling specified for each fax. 

To place a fax on Hold, highlight the entry, right-click to display the shortcut menu 
and select Hold. 

If you put a fax on Hold that was Active, the status changes to ACT/HLD, 
meaning no more retry attempts will take place after the current one. 

If the current attempt is successful, or if it is the last retry attempt, the fax will 
be removed from the queue.  If the current attempt fails and there are more 
retries, the fax will be put on Hold. 

The purpose of holding an Active fax is to enable you to change or delete an 
active fax without being forced to monitor the Pending Queue to wait for the fax 
attempt to conclude. 

7. To authorize/reject a fax that requires your authorization, select a fax whose 
Status is Ready for AUTHORIZATION, right-click and select either 
Authorize/Reject… as appropriate.  If you select Authorize, the fax is 
immediately released for transmission.  If you select Reject…, in the Reject Fax 
dialog that is displayed, specify a note (perhaps explaining why the fax was 
rejected), and click OK. 

8. To release a fax from being on Hold, highlight the entry, right-click to display 
the shortcut menu and select Release. 

9. To delete one of your faxes, highlight the entry, right-click to display the 
shortcut menu and select Delete. 

10. To preview an outgoing fax, select the appropriate fax entry for which the 
Status is Ready for PREVIEW and do either of the following: 

• Click the fax to open it in the Viewing pane 

• Right-click the fax and select Preview from the shortcut menu to open it in 
the fax viewer whose application path you specified on the Viewer/Log 
Options tab  
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If you have opened the outgoing fax in the Viewing Pane, with the fax entry 
selected, right-click and select Release from the shortcut menu to actually send 
the fax. 

If you have opened the outgoing fax in the FAXCOM Viewer, select File…Release 
Fax to actually send the fax. 

If you have opened the outgoing fax in another fax viewer, exit the viewer and 
return to the Pending Queue.  With the fax entry selected, right-click and select 
Release from the shortcut menu. 

Viewing the Activity Log 
The Activity Log lists all attempted fax transmissions, both successful and 
unsuccessful, and any received faxes – for the entire fax service.  On the 
Viewer/Log Options tab (Figure 1-6) you can choose whether or not to display the 
Activity Log (as well as Pending Queue).  If you have chosen to display the Activity 
Log, do the following to view the Activity Log: 

1. Either select Logs…Activity Log or from the Folders list, select the Activity Log 

item  to display the Activity Log. 
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Figure 6-2.  Activity Log 

View the following information: 

Job ID – unique identifying number assigned by the fax service to track the fax 

Date/Time – date/time when transmission was completed 

Type – type of fax attempt, either Tx for a transmission attempt, or Rx for a 
received fax 

Retries – how many retries were made to transmit the fax, not including this 
entry.  This field is preceded by an asterisk when the attempt is the final one 

To – destination fax number 

From – name of the originator of a transmitted fax, or FAXCOM, for a received 
fax 

Pages – number of pages of the fax 
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Code – status code for an unsuccessful transmission; a code of 0000 indicates 
the transmission was successful; all other codes are error codes 

Explanation – 4-letter abbreviation for the status code if the transmission was 
unsuccessful, for example, voic, nois, noan, busy 

Connect – amount of time in seconds on the phone line to transmit the fax 

Speed – baud rate at which the exchange was made, either 14400, 12000, 9600, 
7200, 4800 or 2400 

To display messages sent from the HeartBeat monitoring service, right-click 
anywhere in the Activity Log and click Show HeartBeat Messages.  A checkmark then 
appears to the left of Show HeartBeat Messages menu option. Repeat this step to 
stop the display of HeartBeat messages.  (The HeartBeat monitor is an optional 
service that sends test faxes to verify the capability of the system to successfully 
send/receive faxes.  Once a test job is either successfully delivered or fails to be 
delivered, a delivery status message is returned from the FAXCOM Server to the 
FAXCOM Queue to the user mailbox from which the fax was sent.) 

To add/remove columns, right-click anywhere in the Activity Log and select 
Add/Remove Columns from the shortcut menu.  In the Select Columns dialog that is 
displayed, select entries in the Available Columns list and move them into the 
Displayed Columns list, either by double-clicking the entries or by using the 
Add/Add All buttons.  Remove entries from the Displayed Columns list, either by 
double-clicking the entry or using the Remove/Remove All buttons.  Click the Move 
Up/Move Down buttons as appropriate to cause the entry to move to the left-
hand/right-hand side of the Activity Log.  Click OK to be returned to the Activity 
Log with your selections enabled. 

To print the Activity Log, right-click anywhere within the log to display the shortcut 
menu and select Print to display the Print dialog.  Click OK to send the Activity Log 
to the selected printer.  

Status Codes and Explanations 
While, in theory, it is possible to receive any of 100+ different status codes (error 
codes) for a fax transmission in the fax service logs, typically there are only about 
20 codes that you will see on a regular basis.  They are: 
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0000  All pages OK 
0001  Lost communication with called fax machine 
0002  Received page quality deemed unacceptable by fax machine 
0003  Faxcom unable to transmit due to noisy phone connection 
0004  Faxcom detected voice answer; please check the number 
0005 Early Disconnect.  Remote fax requested a disconnect before 

image was transmitted. 
0006 Late Disconnect.  Remote fax requested disconnect after 

image was transmitted. 
0007  No dial tone detected 
0013  Called fax machine busy 
0014  Phone network busy 
0015  Called phone number ringing but no answer 
0016  Incompatible Group I fax 
0017  Incompatible Group II fax 
0018  Non-fax modem detected 
0021  No destination phone number specified 
0030 - 0041 Fax port modem errors 
0050   After dialing, no telephone network response 
671  Error converting attachment to fax format 
8000  This job was manually deleted 
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Chapter Seven:  Using Phonebooks 
Other than the fax service administrator, only an individual designated as a Public 
Phonebook manager can manage the Public phonebook.  Individual users can, 
however, always view the Public phonebook and select fax recipients from it when 
sending a fax.  They can also create their own Private phonebook, and automatically 
add fax recipients to it when addressing a fax.  

Add Users and Groups to the Public Phonebook 
The Public phonebook is automatically created for you.  To add/modify/remove 
individual users and groups in the Public phonebook, follow the instructions in this 
chapter for adding/modifying/removing users and groups in a Private phonebook.  

Instead of selecting the Private phonebook , however, you either select the 

Public phonebook toolbar button  or select  from the 
Folder list to display the Public phonebook. 

Adding Entries to a Private Phonebook 
You can open your Private phonebook to directly add fax recipients, or you can 
automatically add fax recipients to your Private phonebook from the Send Fax 
dialog when you are sending a fax. 

Do the following to add entries directly to your Private phonebook: 

1. Either click the Private Phonebook toolbar button  or select 
Phonebooks…Private Phonebook from the Folder list to display the Phonebook 
dialog.  Right-click and select New Entry. 
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Figure 7-1.  Private Phonebook 

Note:  You can also select the Private phonebook in the Folder list, right-click to 
display the shortcut menu and select Add Entry – or select File…New…Private Entry 
to display the Phonebook Record – Add dialog (Figure 7-2). 

 

Figure 7-2.  Phonebook Record – Add Dialog 
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2. Using the TAB key to move between fields, enter information in the fields.  The 
following field must be filled in: 

• Fax Number (up to 39 digits) 

The other fields are optional and each allows up to a maximum of 29 
characters, except for Account Number (used with the Accounting function), 
which allows a maximum of 10, and the First Name and Last Name fields, which 
allow a maximum of 19.  (If you are using the Accounting function, consult with 
your fax service administrator for valid account numbers.) 

After you have entered the appropriate information, click OK. 

3. Continue to add entries as needed, using the same procedure. 

4. To make changes to an entry you have already added, select the entry, right-
click and select Modify from the shortcut menu. 

 

Figure 7-3.  Phonebook Record - Modify Dialog 
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5. To delete an entry, select the entry, right-click and select Delete from the 
shortcut menu.  When prompted to confirm the deletion, click Yes to remove the 
entry; click No to retain the entry; click Yes to All to delete multiple selected 
entries; click Cancel to exit without deleting.   

Adding a Private Phonebook Group 
Do the following to create a group of fax recipients in your Private phonebook: 

1. Either click the Private phonebook toolbar button  or select 

 from the Folder list to display the Phonebook.   Right-click 
and select New Group. 

Note:  you can also select the Private phonebook in the Folder list, right-click to 
display the shortcut menu, and select Add Group – or select File…New…Private 
Group. 
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Figure 7-4.  Add New Group Dialog 

2. In the Name field, enter the (case-insensitive) name of the new group. 

3. Select either the Private or Public phonebook radio button according to whether 
you want to select users from the Private or the Public phonebook.  Select any 
entry that you want to add to the group, and then click the Add button.  (To 
remove an entry you have added to the group, select the entry and click the 
Remove button.) 

When you have finished adding entries, click Save and Close. 

4. To make changes to a group you have already added, select the group, right-
click and select Modify from the shortcut menu. 
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5. To print a listing of the group members that includes the information specified 
for the individual member when he/she was added to the User List, select the 
group within the phonebook, right-click and select Print.  Be aware that you can 
also perform the same function by clicking the Print button when 
adding/modifying a specific group in the Group dialog. 

Removing a Private Group 
Do the following to remove a Private group: 

1. Either click the Private phonebook toolbar button  or select 
Phonebooks…Private Phonebook from the Folder list to display the phonebook. 

2. Select the group to be removed, right-click to display the shortcut menu and 
select Delete. 

3. When prompted to confirm the deletion, click Yes to remove the group; click No 
to retain the group; click Yes to All to delete multiple selected groups; click 
Cancel to exit without deleting. 

Sending a Fax from a Phonebook 
When you are viewing either the Public phonebook or your Private phonebook, you 
can select users/groups and automatically be transferred to the Send Fax dialog to 
send a fax to the users/groups. 

1. Select either your Private phonebook  or the Public phonebook . 

2. Select the appropriate fax recipient users/groups, right-click and select Send 
Fax from the shortcut menu to be transferred to the Send Fax dialog in order to 
send a fax to the selected users/groups. 

3. Continue the process of addressing, creating and sending the fax.   

Viewing the Public Phonebook 
Other than the fax service administrator, only an individual designated as a Public 
Phonebook manager can manage the Public phonebook.  Individual users can, 
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however, view the Public phonebook and access it from the Send Fax dialog to 
select fax recipients.  Do the following to view the Public phonebook: 

1. Either click the Public Phonebook toolbar button  or from the Folder list, 
select the Public Phonebook item. 

2. If appropriate, click the column headings to toggle between an 
ascending/descending sort. 

3. To add/remove columns, right-click anywhere in the phonebook and select 
Add/Remove Columns from the shortcut menu; in the Select Columns dialog 
that is displayed, select the Display Selected Columns radio button, then 
check/uncheck the specific columns to add/remove.  Click OK to be returned to 
the phonebook with your selections enabled. 

4. To print the phonebook, right-click anywhere within the phonebook to display 
the shortcut menu and select Print to display the Print dialog.  Click OK to send 
the phonebook to the selected printer. 

5. To view the details specified for a particular user/group, highlight the 
user/group and right-click to display the shortcut menu; select View; click OK to 
be returned to the phonebook. 

6. To send a fax to a particular user/group, highlight the user/group and right-
click to display the shortcut menu; select Send Fax… to be automatically 
transferred to the Send Fax dialog. 

Importing Fax Recipients to a Phonebook 
You can import an existing phonebook database into a FAXCOM Client phonebook 
by following these basic steps: 

• Export your phonebook to a comma or tab delimited ASCII file  

• Create an Import definition file  

• Run the Import utility  

Export your Phonebook to a Comma or Tab Delimited ASCII File 
To export your phonebook to a comma or tab delimited ASCII file, follow the 
instructions in your phonebook manual. 
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Follow these FAXCOM Client considerations when exporting: 

• Each entry must contain at least a recipient name and fax number 

• The length of each entry is up to 1023 characters 

• The fax number must contain all numbers needed to complete the call (i.e., a 
leading 1 for long distance calls, 011 for international calls, etc.). 

• Sorting the ASCII file by last name reduces the running time of the conversion 

The following is an example of a comma delimited file: 
"Clarke", "Nancy", "Biscom", "1-978-250-8877", "1-978-250-1900", 
"321 Billerica Road", "Chelmsford", "MA", "01824", "Capricorn"  

Create an Import Definition File 
Your Import definition file tells the import utility how to interpret each field in the 
ASCII file being imported.  Follow these FAXCOM Client considerations: 

• You can use any text editor to create the keyword header file 

• If the file contains any fields longer than the length showed in the list below, it 
is truncated 

• The keyword header file must exist in the same directory as the ASCII 
phonebook file, with the same name as the ASCII file, but with the .DEF 
extension.  (The header file for PH_BOOK.TXT would be PH_BOOK.DEF.) 

• The order of the keywords in the file must correspond to the data in the ASCII 
file. 

    The following list gives valid keywords and the fields they represent: 
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KEYWORD FIELD  LENGTH  

“NAME_LF” last-first name  Characters divided into 19-character last 
name and 19-character first name 

“NAME_FL” first-last name  Characters divided into 19-character first 
name and 19-character last name 

“NAME_L” last name only  19 
“NAME_F” first name only  19 
“COMPANY” company name  29 
“FAX_PHONE” fax phone number  39 
“PHONE” voice phone number 29 
“ADDRESS” address line 1  29 
“ADDRESS2” address line 2  29 
“CITY” city   
“STATE” state  City, state, zip and country share 29 
“ZIP” zip 
“COUNTRY” country 
“ACCOUNT” account number   20 
“OTHER” or “ “ any other information (While “OTHER” and “ “ can be used multiple 

times, the information is not used by 
FAXCOM Client 

The following is a keyword header file that matches the sample text file in the 
preceding section: 
"NAME_L", "NAME_F", "COMPANY", "FAX_PHONE", "PHONE", "ADDRESS", 
"CITY", "STATE", "ZIP", "OTHER" 

Run the Import Utility 
Do the following to merge a phonebook (that was first exported to a comma or tab-
delimited ASCII file ) into a FAXCOM Client phonebook: 

(You must also have first created an Import definition file to tell the Import utility 
how to interpret each field being imported.) 

1. Select Tools…Phonebooks…Import to display the Import Phonebook dialog 
showing the Input File options and the Destination options. 
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Figure 7-5.  Import Phonebook Dialog 

2. Fill in the dialog as follows and click OK when done: 

Either specify a Source File Name or click the Browse… button to select the file 
from your file directory 

Select the appropriate radio button, either Comma separated values or Tab 
separated values for the delimiter used in the Source file. 

Select the appropriate radio button, either Public phonebook or Private 
phonebook to select the destination phonebook. 

To import into a specific group of fax recipients within the phonebook, check 
the Import to group checkbox and specify/select the specific group.  You can 
also type in the name of a new group to create the group on-the-fly.  

3. Select how you want duplicate entries to be handled, where duplicate entries 
(both within the Source file itself and between the Source file and the 
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destination) are defined as one in which the fax number and the name and/or 
company only are the same, as follows: 

Duplicates: 

LAUREN 9877958440   LAUREN  9877958440 

BISCOM 5268240019   BISCOM  5268240019 

Not Duplicates: 

LAUREN 9877958440   LAUREN  9877958440 BISCOM 

BISCOM 5268240019   BISCOM  5268240019 LAUREN 

Since checking for duplicate entries significantly extends the time duration of 
the import, you are given the following options for handling duplicate checking 
(where you can check/uncheck either option or both options): 

Delete entire contents of phonebook or group before import – if checked, 
specifies that the destination phonebook/group be emptied before the import, 
eliminating any need to check for duplicates between the Source file and 
destination.  If unchecked, the contents of the destination phonebook/group 
remains intact. 

Do not import any duplicate entries or entries that duplicate an existing entry – 
if checked, specifies that the Import utility detect duplicates both within the 
source file itself and between the Source file and destination; when it detects 
duplicates within the Source file, it imports only the first of any duplicate 
entries; when it detects duplicates between the Source file and the destination, 
it does not import the duplicate entry from the Source file.  If unchecked, 
specifies that no duplicate checking take place, either within the Source file 
itself, or between the Source file and the destination.     

4. To verify the exact number of records read/imported, as well as the Import 
configuration settings, open the log file created by the Import utility in any text 
editor.  The log file is located in the same directory as your Source file, with the 
same file name.  For example, the log file created for C:\pbook.txt is 
C:\pbook.log. 

The log file lists any invalid records in your Source file, where an invalid record 
is one that lacks a fax number.  If appropriate, add a fax number to the invalid 
records and run the Import again for only the invalid records.  The file also lists 
any entries longer than the maximum field length that were truncated. 
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Exporting from a FAXCOM Client Phonebook 
You can export an existing FAXCOM Client phonebook into a comma delimited 
ASCII file.  You can copy the exported file to any application that recognizes a 
comma delimited file – including merging multiple FAXCOM Client phonebooks into 
one.  To merge FAXCOM Client phonebooks, you would: 

• Export the entire phonebook or phone group to a comma delimited file 

• Import the file to a phonebook or group 

Do the following to export a phonebook: 

1. Select Tools…Phonebooks…Export to display the Export dialog. 

 

Figure 7-6.  Export Phonebook Dialog 

2. Select Export from public phonebook to export from the Public phonebook or 
Export from private phonebook to export from a Private phonebook. 

3. Check the Export from group: checkbox to export from a specific phonebook 
group (which you select from the dropdown list. 

4. Either specify the Output File Name (including full path) or click the Browse… 
button to select the file from your file listing.  Click OK. 
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The Export utility creates a comma delimited ASCII file, with an associated Import 
definition file you can use when importing.  The file name of the definition file will 
be the same as that of t he export file, but with a .def extension.
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Chapter Eight:  Using the Archive Function 
You can archive folders of faxes either to a network location or to a CD.  If 
appropriate, you can then later connect to the archive location in order to restore 
the archived faxes. 

Sending Faxes to an Archive Location 
Do the following to archive folders of faxes either to a network location or to a CD: 

1. Select a folder of faxes in the left pane, right-click and select Send to Archive…. 

2. In the dialog that is displayed, specify the archive location or click the Browse… 
button to select it, then click OK.   

3. If a password is desired, specify the appropriate password.  Be aware that if you 
will then be allowing other individuals to connect to this archive, you will have 
to communicate to them the archive location and password in order for them to 
connect.  You, however, as the owner of the archive, and the fax service 
administrator, do not need to specify a password in order to connect to the 
specified archive location. 

4. As appropriate to your needs, select (check) the Include subfolders checkbox for 
the archive to include any subfolders beneath the selected folder, the Merge 
contents checkbox to flatten any subfolders’ contents into the parent folder, 
and/or the Delete after Archived checkbox to delete the archived faxes.  (If you 
select Delete after Archived, you are prompted to confirm the archive process.) 

If archiving to an archive location where you previously archived faxes and/or if 
you selected Merge contents, the Confirm Archive Operation dialog is displayed 
(Figure 8-1), asking you to specify how to handle duplicate files it detects (i.e., 
files of the same filename. 
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Figure 8-1.  Confirm Archive Operation Dialog 

5. Select the appropriate radio button, clicking Append when done: 

Prompt each duplicate – specify that the Archive process notify you whenever it 
detects a duplicate file and ask you how to proceed 

Skip all duplicates – to pass over and NOT archive – all faxes whose filename is a 
duplicate of a previously-archived fax 

Replace all duplicates – to replace all previously-archived faxes with all newly-
archived faxes whose filename is a duplicate 

If a duplicate is detected and you selected Prompt each duplicate, the Handle 
Duplicate Image File dialog is displayed, asking you how to handle the 
duplicates. 

6. Select the appropriate radio button, clicking OK when done: 

Skip ALL image files – specifies that the program pass over and NOT archive all 
faxes whose filename is a duplicate of a previously-archived fax. 

Replace ALL image files – specifies that the program replace all previously-
archived faxes with all newly-archived faxes whose filename is a duplicate.  

Cancel Archive process – specifies the Archive process end and do a clean-up of 
any archiving that has already taken place (i.e., it will be as if you have never 
started the Archive process). 

Abort Archive process – specifies the Archive process end, leaving the remains 
of whatever archiving has already taken place. 
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Restoring Faxes from an Archive Location 
Once you have sent folders of faxes to an archive location, you can do the following 
to restore (i.e., access) the archived faxes as follows: 

1. Either select File…Connect to Archive, click the Archive button  in the 
toolbar, or select the Archive icon in the left pane, right-click and select 
Connect…. 

2. In the Archive Path field, either specify the archive location or click the Browse 
button to select it. 

3. If the Archive location requires a password, enter the password.  Click OK.  The 
Archive location is then displayed at the end of the folder list. 

Be aware that it is not necessary for the owner of the archive or the fax service 
administrator to specify a password in order to connect to the archive.  If a 
password has been specified for the archive, it is only individuals other than the 
owner and the fax service administrator who must be informed of the password in 
order to access the archive. 

4. To disconnect from an archive, select the archive location in the folder list, 
right-click and select Disconnect. 

Note:  You must reconnect to an archive each time you launch the FAXCOM Client. 
The archive location is not maintained after you close the application. 
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Chapter Nine:  Using Additional Tools 
In addition to the basic selections in the Tools menu (Options [documented in 
Chapter One]; Change Password [documented in Chapter One]; Phonebooks 
[documented in Chapter Seven]), you may have all of the following selections as well 
(depending on how your fax service administrator has configured you). 

• Advanced Fax Routing (displayed only if you are configured to access the utility) 

• Out of Office (always displayed, but used only if you or the fax administrator 
has created  an Advanced Fax Routing rule action to execute when the Out-of-
Office flag is set)    

• FAXCOM Merge via Client (displayed only if you are configured to access the 
utility) 

Using Advanced Fax Routing 
Advanced Fax Routing is a rules-based utility for specifying actions that 
automatically route incoming faxes, and the menu selection whereby you can access 
the utility is not displayed unless your fax service administrator has configured you 
to access and use the utility.  Moreover, your fax service administrator can control 
not only whether or not Advanced Fax Routing is available to you, but also just 
which Advanced Fax Routing actions you can perform, as follows: 

Note:  While you may not yourself have access to the Advanced Fax Routing utility, 
your fax service administrator can create system-wide rules whose actions 
automatically route your received faxes.  In addition, the fax service administrator 
can create rules that are executed before any rules you create, after any rules you 
create, as well as manage (i.e., edit/delete) any rules you create.   

Basic Rules – whereby you can do all of the following actions: 

 email to people or distribution list – forward a fax to a valid email address or 
distribution list (a collection of contact email addresses) 

Print fax to the specified printer – send a fax to a printer to which you have 
been given access 
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Route fax to people or distribution list – forward a fax to other fax service users 
and groups of fax service users)  

Move a copy to the specified client subfolder – save a fax in a folder created 
under a pre-existing FAXCOM Client folder 

Delete fax -- discontinue any further routing of a fax and remove it 

Make this the final rule evaluated – if condition(s) are met for the rule, specify 
that no further rule evaluation take place  

Additional Rule Categories – whereby you can do all of the rules in a specific 
category, if so configured by your fax service administrator: 

 OCR Actions – whereby you can do all of the following in addition to the Basic 
rules: 

 Extract text and create variable -- use Optical Character Recognition to retrieve 
information from a fax image in order to create a variable (i.e., a placeholder 
that holds the data assigned to the placeholder) 

 Extract text listed in text file and create variable -- retrieve a list of text strings 
trying to find in the image from a text file in order to create a variable (i.e., a 
placeholder that holds the data assigned to the placeholder) 

 Reformat – reformat received fax data, including fax properties and user-
created variables 

 Look up in text file table and create variable(s) – retrieve information from a text 
file in order to continue acting upon a fax 

 Clear all values in a user-created variable -- remove all data currently assigned 
to a variable (i.e., a placeholder that holds the data assigned to the placeholder) 

Barcode Actions – whereby you can do all of the following in addition to the Basic 
Rules: 

 Extract barcode and create variable – use Barcode Recognition to retrieve 
information from a Barcode in order to create a variable (i.e., a placeholder that 
holds the data assigned to the placeholder) 

 Reformat – reformat received fax data, including fax properties and user-
created variables 
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 Look up in text file table and create variable(s) – retrieve information from a text 
file in order to continue acting upon a fax 

 Clear all values in a user-created variable – remove all data currently assigned 
to a variable (i.e., a placeholder that holds the data assigned to the placeholder) 

LDAP Actions – whereby you can do all of the following in addition to the Basic 
Rules: 

 Look up in LDAP and create variable(s) – retrieve information from an LDAP 
directory in order to continue acting upon a fax 

 Reformat – reformat received fax data, including fax properties and user-
created variables 

 Look up in text file table and create variable(s) – retrieve information from a text 
file in order to continue acting upon a fax 

 Clear all values in a user-created variable – remove all data currently assigned 
to a variable (i.e., a placeholder that holds the data assigned to the placeholder 

ODBC Actions – whereby you can do all of the following in addition to the Basic 
Rules: 

 Look up in ODBC and create variable(s) – retrieve information from a database in 
order to continue acting upon a fax 

 Write ODBC – write information to a database 

 Reformat – reformat received fax data, including fax properties and user-
created variables 

 Look up in text file table and create variable(s) – retrieve information from a text 
file in order to continue acting upon a fax 

 Clear all values in a user-created variable – remove all data currently assigned 
to a variable (i.e., a placeholder that holds the data assigned to the placeholder 

Fax Splitting Actions – whereby you can do all of the following in addition to the 
Basic Rules: 

 Split fax into separate documents – create multiple documents from a single fax 

 Reformat – reformat received fax data, including fax properties and user-
created variables 
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 Look up in text file table and create variable(s) – retrieve information from a text 
file in order to continue acting upon a fax 

 Clear all values in a user-created variable – remove all data currently assigned 
to a variable (i.e., a placeholder that holds the data assigned to the placeholder 

If you have been configured to use any of the Advanced Fax Routing capabilities, 
you access the utility by selecting Tools…Advanced Fax Routing.  If no such 
selection has been added to your Tools menu, you do not have access to the utility.  

When you are configured to perform only the Basic Advanced Fax Routing rules, you 
use the more simplified Fax Rules wizard to create the rules, described immediately 
below. 

When you are configured to perform additional Advanced Fax Routing rules 
(OCR/Barcode/LDAP/ODBC/Fax Splitting) you use the complete Advanced Fax 
Routing utility.  For information on using the Fax Rules wizard/Advanced Fax 
Routing utility, click the Help button displayed on any of its dialogs to access the 
online help. 

Using the Fax Rules Wizard 
Do the following to use the Fax Rules wizard to manage basic personal rules: 

1.  Select Tools…Advanced Fax Routing to display the Fax Rules wizard (Figure 9-
1). 
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Figure 9-1.  Fax Rules Wizard 

2. Select  to create a new rule. 

Select (check) the specific conditions to be met for executing the rule, where 
selecting no specific conditions indicates that the rule applies to all received 
faxes.  The following specific conditions are available: 

when out of office – select the check box, then click Next; select the appropriate 
action(s) to execute and click Next (where all actions are explained in the “Rule 
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Actions Explained” section below); specify a name for the rule; review the rule 
description and click Finish. 

with the number of pages in a specific range – select the check box, then click 
Next; in the Pages Received Criteria dialog (Figure 9-2), specify the appropriate 
page range value for Pages Received and click OK.  If appropriate, continue and 
specify additional conditions for the rule. 

  

Figure 9-2.  Pages Received Criteria Dialog 

Once you have specified all relevant conditions, click Next; select the 
appropriate action(s) to execute and, once you have specified all appropriate 
actions, click Next (where all actions are explained in the “Rule Actions 
Explained” section below); specify a name for the rule; review the rule 
description – where you can click any line displayed in blue to edit your 
criteria – and click Finish. 

received from a specified Transmitting Station ID (TSI) – select the check box, 
then click Next;  in the TSI Criteria dialog (Figure 9-3), specify the appropriate 
TSI value and click OK.  If appropriate, continue and specify additional 
conditions for the rule. 
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Figure 9-3.  TSI Criteria Dialog 

Once you have specified all relevant conditions, click Next; select the 
appropriate action(s) to execute and click Next (where all actions are 
explained in the “Rule Actions Explained” section below); specify a name for 
the rule; review the rule description – where you can click any line displayed 
in blue to edit your criteria – and click Finish. 

received with a specific sending telephone number – select the check box, then 
click Next; in the Caller ID Criteria dialog that is displayed (Figure 9-4), specify 
the appropriate value for the Caller ID and click OK.  If appropriate, continue 
and specify additional conditions for the rule. 

  

Figure 9-4.  Caller ID Criteria Dialog 

Once you have specified all relevant conditions, click Next; select the 
appropriate action(s) to execute and click Next (where all actions are 
explained in the “Rule Actions Explained” section below); specify a name for 
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the rule; review the rule description – where you can click any line displayed 
in blue to edit your criteria – and click Finish. 

delivered to me during a specific time span – select the check box, then click 
Next; in the Delivered Time Criteria dialog that is displayed (Figure 9-5), specify 
the appropriate values and click OK.  If appropriate, continue and specify 
additional conditions for the rule. 

  

Figure 9-5.  Delivered Time Criteria Dialog 

Once you have specified all relevant conditions, click Next; select the 
appropriate action(s) to execute and click Next (where all actions are 
explained in the “Rule Actions Explained” section below); specify a name for 
the rule; review the rule description – where you can click any line displayed 
in blue to edit your criteria – and click Finish. 

delivered to me during a specific date span – select the check box (for when the 
fax was delivered to the FAXCOM Client Inbox), then click Next; in the Delivered 
Date Criteria dialog that is displayed (Figure 9-6), specify the appropriate values 
and click OK.  If appropriate, continue and specify additional conditions for the 
rule. 

  

Figure 9-6.  Delivered Date Criteria Dialog 
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Once you have specified all relevant conditions, click Next; select the 
appropriate action(s) to execute and click Next (where all actions are 
explained in the “Rule Actions Explained” section below); specify a name for 
the rule; review the rule description – where you can click any line displayed 
in blue to edit your criteria – and click Finish. 

delivered to me on specific day(s) of the week – select the check box (for when 
the fax was delivered to the FAXCOM Client Inbox), then click Next; in the Day 
of Week Criteria dialog that is displayed (Figure 9-7), select one or more days of 
the week and click OK.  If appropriate, continue and specify additional 
conditions for the rule. 

 

Figure 9-7.  Day of Week Criteria Dialog 

Once you have specified all relevant conditions, click Next; select the 
appropriate action(s) to execute and click Next (where all actions are 
explained in the “Rule Actions Explained” section below); specify a name for 
the rule; review the rule description – where you can click any line displayed 
in blue to edit your criteria – and click Finish 

received with an error – select the check box, then click Next; select the 
appropriate action(s) to execute and click Next (where all actions are explained 
in the “Rule Actions Explained” section below); specify a name for the rule; 
review the rule description and click Finish.  

received without an error – select the check box, then click Next; select the 
appropriate action(s) to execute and click Next (where all actions are explained 
in the “Rule Actions Explained” section below); specify a name for the rule; 
review the rule description and click Finish.  
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when the fax is received during a specified time range – select the check box 
(for when the fax was received by the FAXCOM Server), then click Next; in the 
Received Time Criteria dialog that is displayed (Figure 9-8), specify the 
appropriate values and click OK.  If appropriate, continue and specify additional 
conditions for the rule. 

 

Figure 9-8.  Received Time Criteria Dialog  

Once you have specified all relevant conditions, click Next; select the 
appropriate action(s) to execute and click Next (where all actions are 
explained in the “Rule Actions Explained” section below); specify a name for 
the rule; review the rule description – where you can click any line displayed 
in blue to edit your criteria – and click Finish 

when the fax is received during a specified date range – select the check box 
(for when the fax was received by the FAXCOM Server), then click Next; in the 
Received Date Criteria dialog (Figure 9-9) that is displayed, specify the 
appropriate values and click OK.  If appropriate, continue and specify additional 
conditions for the rule. 

 

Figure 9-9.  Received Date Criteria Dialog 
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Once you have specified all relevant conditions, click Next; select the 
appropriate action(s) to execute and click Next (where all actions are 
explained in the “Rule Actions Explained” section below); specify a name for 
the rule; review the rule description – where you can click any line displayed 
in blue to edit your criteria – and click Finish. 

Rule Actions Explained 
This section explains the actions that can be performed on the fax when the 
specified conditions are met. 

Email to people or distribution list 

Once you have selected (checked) the email to people or distribution list action, 
specify the following to configure the action on the Email Action dialog (Figure 9-
10). 
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Figure 9-10.  EMail Action Dialog 

To – specify a valid email address/distribution list. 

Subject – specify the Subject to be displayed in the email Inbox.  

Send notification only – send only an email message notifying the recipient that 
a fax was received in the default FAXCOM Client Inbox. 

Send notification and include received fax as an attachment – send both the 
email message notification and the actual fax as a message attachment.  

Include reception report in the message body – include fax reception details in 
the body of the email message notification, similar to the following: 
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Include the following memo in the message body – select this option to enable 
an area in which to enter any text you want displayed as the email message 
notification.  

Make this the final destination (delete the fax from the default FAXCOM inbox) – 
select this option to specify that once the fax is delivered to the email address, 
it is deleted and rule processing ends for the fax. 

 Note:  If you are sending only the message notification to the email 
address/distribution list, and not including the actual fax as an attachment, be 
careful about also selecting the Make this the final destination (delete the fax from 
the default FAXCOM Inbox) option.  

Image format – select the format in which to save the received fax, either TIFF 
(to be opened in a TIFF viewer), PDF (to be opened in Adobe Acrobat Reader), or 
Default (to use whichever format [TIFF or PDF] has been specified for this user 
account.    

Add Keyword… – click this button when your cursor is in either the To or 
Subject fields to select keyword/variable items with which to populate the field. 
 Once you click the button, select the appropriate data category radio button to 
display the available items in that data category, either Received Fax Properties, 
User Properties, Current Time and Date, Fax Note, or User Created Variable. 

Then select a keyword/variable item that will be replaced with the actual 
instance of the item. 

print fax to the specified printer 

Once you have selected (checked) the print fax to the specified printer action, 
specify the following to configure the action on the Print Action dialog (Figure 9-
11), clicking OK when done: 
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Figure 9-11.  Print Action Dialog 

Printer Name – select from the network printers available to you. 

Make this the final destination (delete the fax from the default FAXCOM Inbox) – 
select this option to specify that once the fax is delivered to the selected printer, 
it is deleted and rule processing ends for the fax. 

route fax to people or distribution list 

Once you have selected the route to people or distribution list action, specify the 
following information for automatically routing a received fax to another fax service 
user on the Route to Other Users dialog (Figure 9-12), clicking OK when done: 

 

Figure 9-12.  Route to Other Users Dialog 

Name of user to route to – type the name of any user(s), either as the entire 
name, or as part of a string that includes Keywords you select by clicking the 
Add Keyword... button (or click the Browse button to select a user).  Note that 
you can right-click in the Name of user to route to field to display a shortcut 
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menu with the following choices:  Undo, Cut, Copy, Paste, Delete, Select All, 
enabling you to manipulate the items in the string as appropriate. 

Make this the final destination (delete the fax from the default FAXCOM Inbox) – 
select this option to specify that once the fax is routed to the specified user, it 
is deleted and rule processing ends for the fax. 

Add Keyword... – with your cursor in the Name of user to route to field, click this 
button to select Keyword/Variable items with which to populate the field. 

Select the appropriate data category radio button to display the available items 
in that data category, either Received Fax Properties, User Properties, Current 
Time and Date, Fax Note, or User Created Variable. 

Then select a Keyword/Variable item that will be replaced with the actual 
instance of the item.   

move a copy to the specified client subfolder 

Once you have selected (checked) the move a copy to the specified client subfolder 
action, specify the following information for configuring the action on the Save in 
Subfolder Action dialog (Figure 9-13), clicking OK when done: 

 

Figure 9-13.  Save in Subfolder Action Dialog 

To – type any text to be the name of the FAXCOM Client subfolder directly into 
the To field, or click the Browse button to select a preexisting FAXCOM Client 
folder.  Note that when your cursor is in this field, the Add Keyword... button is 
active, enabling you to select fax information properties and variables, either as 
the entire name or in addition to the name you specify in the To field. 
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In addition, you can right-click in the To field to display a shortcut menu with 
the following choices:  Undo, Cut, Copy, Paste, Delete, Select All, enabling you 
to manipulate the items in the string as appropriate 

Make this the final destination (delete the fax from the default FAXCOM Inbox) – 
select this option to specify that once the fax is routed to the specified 
subfolder, it is deleted and rule processing ends for the fax 

Add Keyword… – when your cursor is in the To field, the Add Keyword... button 
is enabled. 

A keyword represents an item of fax information data, i.e., fax properties and 
values of user-created variables.  For example, the Keyword for the Time 
Received property is %miTime%. 

After clicking the Add Keyword... button, select the appropriate data category 
radio button to display the available items in that data category, either Received 
Fax Properties, User Properties, Current Time and Date, Fax Note, or User 
Created Variable. 

Then select a Property/Variable item that will be replaced with the actual 
instance of the item.  For e.g., select Current Date to name the subfolder with 
the current date, i.e., December 2, 2005.  The selected item is displayed in the 
To field.  If appropriate, continue to click the Add Keyword… button and select 
additional items to be concatenated (linked together as one string) to the 
previously selected item(s). As an example, the following string is displayed in 
the To field by clicking the Keyword… button and selecting Current Date, then 
typing the string Sales Order directly into the To box, clicking the Add 
Keyword… button again and selecting Current Time, clicking the Add Keyword… 
button again and selecting Faxcom (for the name of the FAXCOM Server on 
which the document was received), and finally clicking the Add Keyword… 
button again and selecting Pages Received: 

%siCurrDate%Sales Order%siCurrTime%%miwFaxcom%%miwPgs% 

delete fax 

Once you have selected the delete fax action, continue the process of creating the 
rule whereby received faxes that meet the specified conditions are automatically 
deleted. 
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make this the final rule evaluated 

Once you have selected the make this the final rule evaluated action, be aware that 
you can always do the following to toggle between the states whereby a rule is/isn’t 
the final rule evaluated: 

1. In your rule list, locate a red line that says This will be the final rule evaluated, 
as shown below.  

 

2. Select the “This will be the final rule evaluated” line and click Delete.  The line 
automatically changes to “This will not be the final rule evaluated,” as shown 
below. 



 

114 

 

3. To toggle back to the “This will be the final rule evaluated” state, select the “This 
will not be the final rule evaluated” line and click Delete.  

Changing Rules/Rule Order, Deleting, and Printing Rules 
Once you have created rules, do the following to change a specific rule, change the 
order in which rules are processed, delete rules, and print the list of rules: 
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1. Select Tools…Advanced Fax Routing to display the Fax Rules wizard. 

 

2. To change a rule, select the rule and click . 

To change the order of rules, where rules are executed from top to bottom, 

select the rule and click  as appropriate. 

To delete a rule, select the rule and click . 

To print the list of rules, click . 

Setting an Out-of-Office Flag 
With the Advanced Fax Routing utility, either you (if you have access to the utility), 
or your fax service administrator, can create a rule to automatically route incoming 
faxes when you are out of the office. 

In the event there is such a rule to be executed, do the following to set the Out-of-
Office flag: 
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• Select Tools…Out of Office.  A checkmark is displayed to the left of the menu 
selection to indicate the flag is turned on.  To specify you have returned to the 
office, select Tools…Out of Office when the checkmark is displayed to turn off 
the flag.  

Installing and Using the Mail Merge Utility 
The Mail Merge for Word utility enables you to merge and fax customized 
documents prepared from a main document and a data source.  Do the following to 
install and use the utility: 

Installing the Mail Merge Utility 
To install the Mail Merge utility you simply click the Mail Merge for Word installation 
document, to cause a document template to be automatically copied to the 
appropriate template directory. 

1. Double-click the FAXCOM_Client_Mail_Merge.doc item made available to you 
by your fax service administrator.  The following Security Warning is displayed 
(Figure 9-14): 

 

Figure 9-14.  Security Warning 

Click the Enable Macros button to continue and open the document, which is shown 
in Figure 9-15. 
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Note:  XP users must check the Always trust macros from this source check box in 
order to activate the Enable Macros button. 

 

Figure 9-15.  FAXCOM_Client_Mail_Merge.doc 

Double-click the Install button to automatically copy the template to the 
appropriate template directory and display the following successful installation 

confirmation . 

In addition, the FAXCOM Merge via Client selection is added to the Tools menu 
within MS Word. 

Note:  To uninstall the utility, follow the steps immediately above, with the one 
exception being you click the Uninstall button. 

Using the Mail Merge for Word Utility 
Do the following to merge and fax your documents: 

1. Make sure that you have logged in at least once to the FAXCOM Client 
application. 
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2. Create your data source.  Make sure that you include Fax Number as one of the 
data items.  (This is the only data item required by the FAXCOM Mail Merge 
utility in order to fax the customized merged document.)  

3. Within MS Word, create your main document with the appropriate Merge Fields.  

4. Within the main document, select Tools…FAXCOM Merge via Client to display 
the FAXCOM FaxMerge Mappings dialog (Figure 9-16). 

 

Figure 9-16.  FAXCOM FaxMerge Mappings Dialog 

5. In the Fax Number box (marked with an asterisk as the only field required for 
faxing), select the Fax_Number data item from the drop-down list of Merge 
Fields, as shown in Figure 9-17. 

 

Figure 9-17.  Fax Number Mapping 

6. To include a cover page, in the Cover Page box, change the default of NO 
COVER PAGE to DEFAULT COVER PAGE or select a specific named cover page.  
You can then specify a Subject to be displayed on the cover page.  

To select the fields to be displayed on the cover page, in the Data Source field 
mappings area, change the default of NOT MAPPED to the appropriate field.  For 
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example, to print the recipient’s name on the cover page, in the First 
Name/Name box change the value of NOT MAPPED to Name, as shown in Figure 
9-18. 

 

Figure 9-18.   Name Mapping 

7. To specify the circumstances by which you receive a return status for the fax 
transmission, in the Return Confirmations Return box, select either All faxes or 
Failed faxes only. 

8. Click OK to send the fax. 

A prompt such as that displayed in Figure 9-19 is displayed. 

 

Figure 9-19.  FAXCOM FaxMerge Prompt 

9. Click Yes to submit the faxes.  Depending on what you selected for Return 
Confirmations, you will receive a confirmation for all faxes sent or failed faxes 
only. 
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